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End User License Agreement
The purchase of the license for this software carries no guarantee or warranty either expressed or implied regarding
its ability to predict the outcome of any race.
No guarantee or warranty can be made by anyone at any time regarding the outcome of events which include or
involve the element of chance. Thus if the licensee chooses to pursue bets on races using data derived from this
software, such decisions and all results thereof and consequences there from are entirely the responsibility of the end
user. Neither the originator nor the seller bears any responsibility for damages incurred by the end user which may
result from the use of this software.
The material contained in this program is intended to inform and educate the user and in no way represents an
inducement to gamble legally or illegally. It is intended for the entertainment and exclusive use of the licensee only
and may not be shared with others for any purpose. All rights are reserved.
Except for brief passages used in legitimate reviews, no parts or products of this program or the accompanying
documentation may be reproduced, recreated, distributed or utilized in any form or by any means, electronic or
mechanical, without prior written permission.
This product is produced and distributed in the United States of America.

Address all inquiries to:
handicapping@paceeval.com

Register your license by sending an email to the above address. Please send a registration email with the following
information:
Name, address, city, state, phone number (optional), email address, CD registration number and
where you heard about the program.
When contacting us about the program, you will be asked for your CD registration number. The information you
provide will be used only to contact you regarding changes or updates to the program when they occur.
A web site for support of our customers is established at http://www.paceeval.com/. This web site will be used to
keep you informed of updates and ideas on using the program. You can email us or there is a page on the web site
where you can register.
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Introduction
This program is designed to help you handicap the fewest number of horses and have the largest percentage of
winners in the group you handicap.
PacePlus includes the full set of capabilities and display of Pace Evaluator and many more. As well as providing the
familiar EPR. FFR and TPR information, PacePlus also provides a screen on which the user may view the Sartin
velocity information in feet per second or adjusted call times.
The Print Preview screen incorporates the original Pace Evaluator screen and the new PacePlus screen on which
only on line of information per horse is displayed.
PacePlus also includes a feature to permit the user to scratch horses and a separate control to remove (hide) a horse
on the Print Preview display or to remove from the output products those horses the user does not wish in his
selections for final decisions on a race.
The features added to the program are numerous but hopefully not enough so to be intimidating.
It is also expected that a user will not use all features of the program but will find some that work for him and those
will become his predominant tools for handicapping.
Custom PP Generator is an alternative to downloading the Premium Plus PPs. Brisnet provides a free software
package called Custom PP Generator from their website which permits the user to display the equivalent of the
Premium Plus PPs from the .drf data file. The Custom PP Generator provides numerous display options.
Data Files are a part of the PacePlus program. You can import data for the program from four different source files.
The usable source files are the Brisnet DRF Data File (Single) or MultiCAPS Data Files and from the Thoroughbred
Sports Network (www.tsnhorse.com) TSN Past Performance Data Files or ProCAPS Data Files. All of these source
files contain all the data used by PacePlus with the exception that the TSN PP Data Files do not contain an
equivalent to the Brisnet Prime Power numbers. In the case of this as a source file, there is no Prime Power number
displayed or printed.
Don’t forget to register your license for PacePlus.
When you register, you will be notified if there are updates. You can also check for updates on the web site.
www.PaceEval.com. Updates are found on the purchase page at this time (subject to change). You can also register
on the web site.
.
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Section 1 - Handicapping
Program Download
The following pictures will show you how the program is set up on your computer after you install it. They will also
give you ideas on how to set up folders and files to help keep information organized so it will be easier to find and use.

1

2
When you install the PacePlus
program this is how it will
look on your computer.

These files are put
here for you to use
while looking at the
examples in the
manual.

Zip files that you download
from Brisnet to use in the
program are put in the
BrisDownLoad file.
When you open the program it
will unzip the file and put the
zip file in the Archive file.
The program will then put other
information that you need in the
DRFData file
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A benefit of including the
YYYYMMDD
date
format in the file name is
that the files are sorted by
track and then by date. By
doing this no information
will be overwritten and it
date.is easier to find the track
and the date.

3

I used this format in the
Result files for the same
reason, easy to find what I
I want.
want.

The DRFData file is
where the information is
put after the program
unzipped the download
from Brisnet.

When you open a race this is
where the program goes to
get the information you need
to run the program.
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4

When you open a race
what you see looks like
this. You choose the
race and open it to
handicap the days race.

5
In the Results folder I
make a folder for each
track that I work with as
shown here.

Inside of each folder I
make another folder for
charts. If you do not use
charts do not make this
folder.

6

When I download Results from
Brisnet I put in the File name the
track, year, month and the day. It
looks like these.
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Program Directories
The PacePlus program establishes a set of directories at installation which it uses to store the various files used by
the program and the user. These directories established by default are shown on Page 1-1 under the topic Program
Download. If the user needs to see the list of directories and their contents, they are listed in the manual but the user
may also display them from within the PacePlus program.
To display the actual directories for your system, select the Show … menu and choose the Directories option. If you
want to know where PacePlus is looking for the files it uses, this display shows you.
If the user has opted to use the default directory installation options, the program presents a new window which
shows the installed directories as shown in the image below.

For a more detailed description of the Directories display refer to the manual’s Technical Section in the Program
Directories topic beginning on page 2-2.
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Getting and Saving DRF Data Files
This program works on downloads from Brisnet or Thoroughbred Sports Network (TSN). You will need to set up an
account with Brisnet or TSN to buy downloads for this program. In their ProCAPS files, TSN does have a TSN
Power Rating comparable to the Brisnet Prime Power ratings. The numbers are different values from Brisnet and are
not in the cheaper TSN file, the .EG file.
This is an example of the Brisnet home page. To obtain a file for your
program you have to come to this page and click on Programs & PPS.

After you click on Programs & PPS you
will get a page with a that the top looks
like this.
Then click on Data Files

Next you will get a page with a top like this.
This is where you would make a shortcut if
you have not done so.
Click on DRF Data Files (example of page
follows).
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Find the track and then the date you want
to handicap and click on the date. Be sure
the date has a p after the date or it will
not have the morning line odds or the
Brisnet power numbers.
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1

After you click on the date you want
this prompt will appear. This appears so
Brisnet knows it is you so they can bill
you, also no one else can charge on
your account.
Then click OK.

2

After you click OK this
prompt will appear.
Click Save to save the race.

Make sure this is
where you want
to save this file.

3

Click
Save to
save the
file.

4
This shows that the
download is complete.
Click Close to finish.

After downloading the file to BrisDownLoad, when you open the program it will unzip the file. It will then put the
zip file in the Archive folder and the unzipped information in the DRFData folder. The DRFData folder is where the
PacePlus program acquires information for the program.

1-7

Making shortcut for DRF Data Files

When you go to the Brisnet
home page you click on the
Results & Charts.
You will then get this page.

1

When you get to this page put
your mouse cursor
curser on the page
and right click.
You will see this menu.
Click on Create Shortcut.
You will then have a shortcut
on your desktop like this one.

2
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Getting and Saving Results

1
Go to the Brisnet home page
and click on the Results &
Charts.

2
After clicking on Results &
Charts you will get this page.
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3
With this page you choose
the track you want and then
the day.

4
After you choose the track and
day and then click on the day
you want you will get this page.
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5

On this page go to File
then click on Save As.

Then you will get this window.

In the File name window
type in the track, year,
month and day as shown in
the above window. The
day of the week is
optional.

6

7

Make sure the Save as type window is
the same as shown here. What you are
seeing here is NOT what is in the
window when it opens. You have to
click on the right of the box and choose
what is shown.
The window says:
Web page HTML only[*.htm;*.html]
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Making shortcut for Results

When you get to this page put
your mouse curser
cursor any where
on the page and right click.
This menu will appear.
Click on Create Shortcut. You
will then have a shortcut on
your desktop like this one.
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Custom PP Generator
Custom PP Generator is also discussed in Section 2, the technical description portion of the manual.

When you click on free
software this is the
page you will see.

1

Install this free software you
will be able to view the racing
form. This installation will also
put an icon on your desktop.

2
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When you open Custom PP Generator
click File and then Load File so it will go
to where the files are located.

3

Where it goes is not where our files are stored. So
here is what to do to get files from your DRF Data
files. The next examples (4 &5) will show you how to
set things up so when you click on Load File it will
go to where you have your files.

Click on System and you will get this
menu.

4

Click on Default File Directory and
you will see this menu.

In this menu you need to go where you
have your DRF Data files.
You need to follow the path to your DRF
Data files if they are different than the path
shown.
If you installed the program from the disk it
will default to C drive and make a folder
called PacePlus. In the PacePlus folder will
be a folder called DRF Data. This is where
the information is stored that you need to
create the racing form with Custom PP
Generator. Following these instructions
will make it easy to find the file you need to
make the racing form.
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5

Running the Program
At this time you should have downloaded your race file into BrisDownLoad. When you have done this the program
will unzip the data file into the DRFData folder and move the zip file in the Archive folder.

To run the program start with the Data Import button and pick the file for the race you want to handicap. When you
click on Data Import you will see the following.

Find the race you want, highlight it, and then click Open.
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Find the race you want and highlight it, then click Save.

You will see this screen showing that it is saving the data.
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Find the race you want, highlight it and click Open. You will the get the following page.

You will note that a Print Preview button now appears I usually go to the Print Preview button and click on it. Then I
can preview the races showing all the horses and their information. You can exit the program by the Quit button or
by the X in the red box in the upper right hand corner.
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Information….PacePlus
Whenever we can, we shorten examples. The first one is full size and the second one is the shortened one and the
one we use in the manual. We have shortened any pages that we could. We have kept the top and bottom the same
and took out only blank middle space.
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Running Style of a Horse.
E (Early) = A horse that exhibits this running style is one that typically vies for the early lead or
whose best races are run on the lead. These horses do not successfully rate behind a pace setter.
E/P (Early/ Presser) = A horse that exhibits this running style is one that runs second or third within a
few lengths of the lead, early in the race, before trying to run down the leader. This type of horse may
run in the front end but unlike the “E” horse, its best race is behind a pace setter.
P (Presser) = A horse that exhibits this running style is one that runs in the middle-of-the-pack ,early
in the race, before trying to run down the leader. A “P” horse may at times run close to the leader but
rarely, if ever, challenges for the lead early. Unlike an “S” horse the “P” horse doesn’t typically run
from the rear of the pack in its better races.
S (Sustain or Closer) = A horse that exhibits this running style is one that runs, early in the race, in
the back of the pack before trying to run down the leader.
NA (Not Available) = This horse is a first time starter or one who hasn’t enough meaningful running
lines to accurately assess the horse’s preferred running style.

Odds
Morning line odds from lowest to highest are as follows:
1 – 10

3–5

7–5

2–1

4–1

7–1

12 – 1

1–5

4–5

3–2

5–2

9–2

8–1

15 – 1

2–5

1–1

8–5

3–1

5–1

9–1

20 - 1

1– 2

6–5

9–5

7–2

6–1

10 -1

50 – 1

The odds in red are the ones you see most often.

Information….Technical Manual.
The following things are in the Technical Manual. It would be to your advantage to look at following things.
•
•
•

PacePlus Overview…………………….2-1
Data base (History) Function…………..2-16 – 2-24
Hide horse……………………………...2-38 – 2-39

If something is not clear to you then you should check the Technical Manual. This should clear things up and if it
doesn’t then email us a question.
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Sections of the Program
This is the page that starts all of the handicapping methods that are in this program. There are four different ways to
look at a race. I will explain each one and give you an idea on how to use each one. The example below is at the
point where we have imported a race with the Data Import button. We then opened the race as you can see because
the race area is high lighted in blue. Also in the blue header, which shows the track and date, it states that the current
track is Belmont Park and gives the date.

Track and date
Race number

This button will show you:
1.
Print Preview — the
main program.
2.
Pace Evaluator — this is
the same as our first
program with a few new
things for you to use.

This button will show you:
3.
Adjusted Call Times — we adjust the times
and show all the Past Performances so you
can compare.
4.
FPS or Feet Per Second — this is based on
Dr. Sartins ideas. It shows all Past
Performances.

Using the two buttons at the bottom of the above image there are four ways to look at a race.

Below are examples of the four sections of the program.

1

Print Preview or the PacePlus Program
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2

Pace Evaluator Program

3

Adjusted Call Times part of the Program

4

Feet per Second part of the Program

In the next pages of the manual I will explain the four sections and ways that you can use them to handicap. This
way you can see how each screen or program can work and how it ties in with PacePlus.
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To See One Race per Page

To see one race per page go to the bottom of the page move your curser over the blue line until you get the double
arrow. Pull the bottom of the page up until it looks like the example above. Then click Next and see if only one race
shows on the page. If more than one race shows move the bottom up farther and then click Next to see if only one
race shows like the example below. If you are at the race you want you must get the double arrow, pull the page up
then click Reset and follow the instructions above. When you come to the race you want, get the double arrow and
pull the bottom of the page down. Then you can bring down the Show Detail and the Hide horse box and continue
handicapping.
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Print Preview … Explanation

The following examples are to show you about the sections that are in the red box above.

In Print Preview, Reset
takes you to race 1 or
the first page. The
program defaults to
page one

1

Next takes you to the
next page.

Foe Results see below.
For Race Con. see next page.

See below.

•
•
•
•
•

When you click on the Program Mode the pull down gives you 4 options.
Contenders Mode is a section that gives you what we think are the 4 best horses. The winner is in this group
most of the time.
Pace Evaluator is the section giving you the EPR, FFR and TPR for every past performance that the horse
has.
Display/Print gives you 2 more options. Normal is the default option. User customized is to print the races
that you have saved using the Show Detail option. When you go to User customized you will see what you
saved and then you would click print all races.
Close is to close the Print/Preview window.
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2

The print section has 2 parts.
The one grayed out is for the
PaceEval section.
The section highlighted is for
the Print Preview section.

The APV is the average
purse value in thousands.
The column is headed APV
and when you click on it
the drop down menu is
checked.
If you uncheck Show APV
you will get another
section of 3 columns.
These columns are
explained below.

In the 1st column you will see a C, C1 (claimed) or T, T1 (trainer). C or T means that this is the first race since the
horse was claimed or changed trainer. Being claimed means that they will have a new trainer but that is not noted.
C1or T1 means that this is the second race since the horse was claimed or changed trainer. They can have a new
trainer and not be claimed. For a more detailed description refer to the technical section on page 2-41.
In the 2nd column it will show O (owner trainer) or B (breeder trainer).
Third column it will show sR (changing from running sprints to routes) or Rs (going from routes to sprints).
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3

When you click on Results the box
for the results appears on the left of
the page. Then go to A

4
A
C

When you click
Open the Open
Results file will
appear.

After you click Open the
results will appear in the
box as shown in this
example.

B
High light the race
you want, then click
Open.
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5

When you click on Race Cond and
then on the race number the Race
Cond box will appear on the left.

Print Preview….Header

This section is about the columns in the red box. The columns not in this box you should understand so I will not
explain them.

Brisnet numbers: These numbers are listed in the Bris No. column. We list the 1 thru 4 numbers. After each
number except the number 1 there is a number in blue. We have taken the decimal number and put the difference (in
blue) between these numbers. 1 – 2 = diff, 2 – 3 = diff and so on. We have not given the 5th horse a number 5 but
we have given the difference again in a blue number. In the example above the 13 horse is Brisnets 4th pick with the
difference between the 3rd and 4th horses decimal number being 7.05.
The S column is for sprint races. If the race is a route race then this column will be an R column. The S is early pace,
like the EPR and the R column is late pace like the FFR in the Pace Evaluator program.
The %E column is how a horse uses energy and 0.00 is the best.
AR is a propriety rating value. It is giving a value to show the horses ability to win. The highest number is best.
Spd is the best speed rating from the 4 most recent races.
In the AR and Spd columns the blue numbers are the more recent and the red numbers are later.
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Mu is a propriety rating value where 0 is best. Horses with a zero or one are where winners should be found. If there
are no zeros then 1’s or 2’s would be the next group for winners. We have found that plus or minus makes no
difference.
Class gives the highest class race that the horse has won. The number before the class shows the past performance
where this class was won.
PC is pace class that Dr. Sartin talks about.
EPR and TPR are the best number from the 4 most recent races from Pace Evaluator program.
The A column is the horses ability to win. The best is A+, A and then a. Horses can win with nothing in this column
but if there is some type of A in the column that is better.
The B column is ONLY for race distances of 7F, 7.5F and 8F. If there is a plus in this column it means that the horse
has finished 1st, 2nd or 3rd in a race at today’s distance.
The C column relates to the FPS section. If you look at the FPS screen on the far right side some past performances
(PP) have a plus. This plus means that the numbers in this PP is equal to or above the averages at the top of the
columns except the Dec column. The Dec column is equal to or less than the average above the column.
The D column is about the horses’ last race. If there is a plus in this column it means that the horse gained on the
winner between the second call and the finish and then finished 2, 3 or 4th.
The E column is a propriety rating value where the lowest number is the best.
APV is the average Purse value for the horse. If you go to the APV at the top in the grey header and uncheck APV you
will be shown a different set of values. There will be 3 columns. The fires one will show a C, C1, T or a T1. The C
shows the horse was claimed after his last race. The C1 indicates that the horse has run 1 race since he was claimed.
The T shows the horse changed trainers after his last race. The T1 indicates that the horse has run 1 race since he
changed trainers. The 2nd column shows an O for an owner trainer. In this column if there is a B it means that the
breeder is the trainer. The next column shows that a horse is going from a sprint race to a route race (sR). Going
from a route to a sprint is shown by (Rs).
The 1, 2 and 3 columns at the far right are where numbers are saved from the Show Detail box to the Print Preview
page.

are put
here.

Show Detail box

These number
when saved….
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When you click on a header it adds a number to each column. If you click on a column and then re-click on the same
column it will not add another number to that column. You should also know that column 1 should always add to at
least 8. If 2 horses have the same number the column could add up to more than 8.
Has not raced in the USA: This means that the horse is from a foreign country with no races in the United States.
Most races not USA. Horses with this notation have run less than 60% of their races in the United States.
From lower level track: We have set tracks up in 5 levels. Horses from a number one track (in condition) can win at
any level. A horse from a level 3 track, we feel, can win at a level 2, 4 or 5 track but not at a level 1 track. Now if he
is a young horse with not many races or not established he could possibly win at a level 1 track. Below are 3 of the
track levels.

As I said horses from the level 4 track I would not expect to win at the level 1 and 2 tracks unless they have not run
many races.
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Print Preview …. Belmont Stakes
This program is different than other programs. It is not put together and does not work like other programs you may
have seen. In the FPS and the Adjusted Call Times sections you have past performances (PP’s) to work with, this is
not true with this section. Everything leads to this section and here is where it changes. This program has columns
and information in each column is not from the same past performance line. We have picked what we think will
show you the winner. We have not used just one PP to obtain our information most of the time it comes from the 4
most recent PP’s.
The men that have been beta testing the program are long time handicappers. One man has worked at a track for 35
years. The others have been handicapping for many years. After working with the program for almost a year
everyone seems to like the program. We have used their input in the program and I know it has made it better.
Now I will start showing you how I handicap with the program.

This page shows the race to be handicapped. It shows
the large blue Show Detail box, the red Scratch box
and the small blue Hide horse box.
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While I was putting this program together I always wanted to know who might win so I started looking at the
program as follows. You do not need to do this. I would click all the headers. The only headers that accumulate
counts are in the green and aqua squares in the example below. You can sort the column by clicking on the header.
Clicking the header will sort the column from high to low, best at the top. If you clicked on the S column the horse
at the top would get one point in the column 1. The rest of the horses would get no points for column 1. The top
horse would also get one point in column 3. The 2nd horse would get two points for column 3. The 3rd horse would
get three points and so on.
Column 1 shows how many times a horse was at the top in a column. The 2nd column gets points from headers in
aqua Spd, PC, EPR (sprint) or FFR (route) and E. Column 3 gets points from all headers, the green and aqua.

1

I would open the program, go to Print Preview, and click all the headers and then click on the 3 columns to the far
right. Column 1 shows the probable winner to be Big Brown or Da’ Tara.

2

Column 2 shows Big Brown and Ready’s Echo.

3

Column 3 shows Big Brown and Da’ Tara. If the same horse is at the top in all 3 columns then that horse is probably
the winner. In this case it is not true as we all know Big Brown did not win.
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4

When I started to look at the Mu column I thought all winners would come from either the + or – group. I have found
that winners tend to come from 0, 1 or 2 (±). I also thought I would handicap the group with the most +’s or –‘s and
eliminate the other. But I found that sometimes the group that had only 3 horses contained the winner. At the end of
this I will examples of races that you will see. This race is not the norm because it has no 0’s, only one 1 and no 2’s.
When you see a race like this the winner could be the 9 horse in the red box or it could be the 6 or 2 horse (in the
green boxes). To be a winner, like the ones in the green boxes, the high horse has to be at least 7 or 8 points higher
than the horse below it. I would not think it would be the 15 horse because the speed rating is the lowest of any of
the other horses, the AR number is the lowest and he has no number in column 1. This leaves the 9, the 12 horse or
one of the horses with a +3.
The %E column is to show how much energy is expended and 0 is the best. With this column the winner should
come from the red or green box. The winner should be at or close to 0.

5

Again the horse in the green box or the 4 horses in the red box are to be considered for the winner. At this point,
looking at the 5 examples, it looks like the winner should be Big Brown, Da’ Tara, Ready’s Echo or Tale of Ekati.
Remember you do not have to do the 5 things above.
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Now let us start handicapping. I’ll start this race eliminating horses with the Spd column. Click on the header Spd to
sort the column.

I would eliminate the 2, 8 and 10 horses
because they are the lowest Spd numbers. I
would not take away the two 99’s; they are
only 1 point from the 100 but 4 points from
the 96.
So check the 2, 8 and 10 horses in the Hide
horse box and click Refresh.
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This is how the race would look after you clicked Refresh.

1-33

Now go to the R column, the R column is for routes or late
speed. Looking at the R column, and if the program did not
pick number 6 I would be sure to place a bet on this horse.
The 153.5 for this horse makes him the only horse to bet.
R column
But let’s continue thru the process. Using the R column
I I
would take out the bottom horse.
Hide
horse
horse
So Big Brown is checked in the Hide
box box
and and
thenthen
click Refresh. You now have 4 horses so you will no longer
need the Hide horse box so click the X in the red box to close
this box.
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Now go to the R column, the R column is for routes or late
speed. Looking at the R column, and if the program did not
pick number 6 I would be sure to place a bet on this horse.
The 153.5 for this horse makes him the only horse to bet.
R column
But let’s continue thru the process. Using the R column
I I
would take out the bottom horse.
Hide
horse
horse
So Big Brown is checked in the Hide
box box
and and
thenthen
click Refresh. You now have 4 horses so you will no longer
need the Hide horse box so click the X in the red box to close
this box.
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Bring down the Show Detail box. Now click the headers S, R, AR, Spd, PC, FFR, TPR and E. Next sort the 1, 2, and 3
columns. When you have clicked on a header if the column does not count it will not add a number. The columns
that do not add to the count are the %E and the Mu. When you have clicked on a column that adds a number to the
count and then re-click that same column it will not add a number to the column a second time.

In all 3 columns you are shown 2 horses, the 6 and 3 horses. The winner should be one of these horses and would be
the two you would bet to win.
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Click Save to save the numbers in the
Show Detail box to the Print Preview page.

If you want to take this race and
information to the track as you see it
here then click Capture and the green
box will appear.
Now click OK.
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Now if you go to Program Mode , click
User
on
onDisplay/Print and
andthen
thenon
onUser
customized
customizedyou
youwill
willsee
seethe
therace
raceyou
you
have
havesaved.
saved.(an
(anexample
examplefollows).
follows).
When you want to go back to the regular
program you have to go back and check
Normal
Normalaas
s shown
shown in
in this
this example.
example.

To print the races you have saved click on
Print Data, Print Plus and then All races.
Then all the races you have saved will be
printed as you saved them. The races on
this page are examples.
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Race 11 results.
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Pace Evaluator … Explanation
The page below explains things you need to know about the printed pages. The image below is a sample of the
printout data (header) for a single horse. The information layout is the same for every horse. The header is the area
between the two lines. In the header it gives the horse’s name, Brisnet Prime Power rating, running style, percentage
number, morning line odds and days since last race. The printout shows pace data from the past performances for as
many as 10 prior races with an average given for the four most recent races and then for the total number of races. If
there are only 4 or 5 prior races, the average is given for the total number of races rather than two averages.
This is Brisnet’s Prime Power rating. [2nd]
shows it’s the second highest power
number of the race.

This is the horse’s
Running style.

This is the
morning line
odds.
This figure is
explained below.
This is how many
days since horse’s
last race.

Pace Evaluator Printout Segment
The image below is from the Past Performance portion of the PDF download file stored in the Racing Form
directory or the Custom PP Generator display. It shows the racing form’s data for each horse’s previous race.

Pace Evaluator Percentage Calculation
The 100% shown in the header or first example (Pace Evaluator Printout Segment) was not figured from the
second example (Pace Evaluator Printout Segment). You would not get 100% from the second example.
To figure the % we look at the figures inside the red square. There are 10 races shown above. What is important is
the number of times the horse was 1st or 2nd. Since there are 10 races, this gives you 40 numbers that you are looking
at. Take the number of times the horse was 1st or 2nd and divide it by 40 and you have the % [percentage] figure
shown in the header. You will get 18% using the example shown.
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In theory, the better the percentage, the better the horse, but this is not always true. I use it as a piece of the puzzle in
picking the winner.
In this section we will explain how you can use the Pace Evaluator section to handicap the races. We have added to
this section the ability to use the Show Detail, Hide horse and the Scratch features of the program. I will also say that
everyone needs to work races after they are run to see why they won or lost. People need to know not only why they
won or lost but what is going on at the track they are handicapping. Everyone that uses this program will see and
work it differently. You have to work the program so you can find out what works for you. This section may not be
the one that works for you, one of the others may be better for you.
I had some people who had the first program that decided that it was only giving them low paying horses so they
didn’t use it. I know that by not circling the 4 low odd horses it gives you horses that will pay more. In this program
we will not look at the Brisnet numbers or the odds. The problem could be that by looking only at all TPR’s you
could get horses with high TPR’s that can not win and you will not know which horses they are.
Hopefully we will be able to show you how to get around this problem. Remember that everything starts with the
yellow screen.

At this screen click on Print Preview
and you will get the following
example below.
page.

You get to Pace Evaluator by going to Program
Program
Mode
Mode and
and then
then click
click on
on Pace
Pace Evaluator.
Evaluator.
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The Pace Evaluator section allows you to use the following parts of the program. The Show Detail allows you to see
what is in the Print Preview (PacePlus) section. I do not use the Show Detail box in the Pace Evaluator section. You
can use it if you think it will help. The Hide horse box is available in the Pace Evaluator and Print Preview (PacePlus)
sections and I use it in both sections. When I find a horse I want to eliminate I check the horse in the Hide horse box
and click Refresh. Then the horse is eliminated. The Scratch box takes away horses that have been scratched. Casino
Drive was scratched and looking at the Scratch box you can see that I have scratched him so he will not show on any
other pages that are in this section.
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Pace Evaluator ... Breeders’ Cup…Race 2

There are 2 pages to this race.
You have the Hide horse to
eliminate horses that you do not
want.
The following pages will show
you how you can handicap the
race.

We are looking at a 6.5F race. With this in mind we will look at the horses EPR and TPR.
I have found that having a high TPR it cannot win if it does not have a high EPR, for a route race look at the FFR and
the TPR. I have put the EPR and TPR in green boxes. I have put red boxes on the EPR’s and TPR’s that I would use.
See examples on the next 2 pages.
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After looking at the race I would keep the horses with the red boxes. So you would check the horses that you would
eliminate in the Hide horse box. Then click Refresh to eliminate the unwanted horses, then you will have the
example shown on the next page.
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You now have 5 horses.

This horse has a EPR of 102 but
the TPR is only 183 so I would
eliminate this horse.

After eliminating horse 11 you would have
4 horses, numbers 9, 10, 12 and 13.
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As you can see the 2 high EPR’s are 9 and 10. The
highest TPR is 10. Horses 12 and 13 both have 203
for a TPR. So which 2 do you bet? For more help go
to the Program Mode and click on PacePlus. In
PacePlus race 2 will look like the example below.

I have clicked all the
headers and then clicked
Save to put the numbers
on the Print Preview
screen
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Looking at columns 1, 2, and 3 (in the red box) you can see which two you would pick. Column 1 would be 10 and
13. Column 2 would be 10 and either 12 or 13 since they both have a number of 11. Looking at 12 and 13, who is
better? Looking at column S 13 is better (162.4 compared to 161.3). Looking at speed 13 is better. Looking at PC 12
is better. Looking at APV 13 is the best horse so column 3 would be 10 and 12.
So your 2 horses to bet would be 10 and 13.

But….
There is another way to look at the race.

I have blocked out the columns that are not used for this evaluation. Since I am looking for 2 horses to bet I would
pick the 2 highest numbers in each column. In the Class and the C column all horses are equal so none are picked.
After picking the 2 highest in each column count the boxes for each. You would have the following
•
•
•
•

Horse 10
Horse 13
Horse 12
Horse 9

3 boxes.
3 boxes.
2 boxes.
4 boxes.

Because this horse has only1 box, I would eliminate this horse.

Now you have horses 10, 13 and 9
The horse to bet would be the 9 horse. The second horse would be the 10 or the 13. I would take the 10 over the 13
because the 10 has the higher speed rating, PC number and the higher running style. So the pick would be the 10 and
9 horses to bet.
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Race 2 results.
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Pace Evaluator ... Belmont Stakes
This is the Pace Evaluator page of race 11 of the Belmont Stakes.

Having brought down the Hide horse box check
horses 2, 4, 7 and 8. These horses have TPR’s that
are less than 180.
Click Refresh and you will see the following page.

Looking at the above pages I have put red boxes around the FFR’s and TPR’s. I have chosen to keep TPR’s that are
180 and above. Anything less than 180 has a blue line thru it. I am looking at the 4 most recent races. Next I would
bring down the Hide horse box and check horses 2, 4, 7 and 8. Click on Refresh then you will get the following page.
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On the previous pages after you clicked on Refresh this
ispage
whatisyou
would
Yousee.
have
5 horses
The left.
what
you see.
would
You
have 5left.
horses
obvious
choice
to
win
is
Big
Brown.
But
look
at
the you
The obvious choice to win is Big Brown. When
look at the lengths that he has won by in his last 5
races they add to 39. I believe when the lengths that a
add
upwins
to 39.by in consecutive races is over 25 the horse
horse
is usedyou
up.look at the FFR’s horses 1, 3 and 10 all have
When
95’s
but
BigatBrowns
TPR Horses
of 187 makes
him10
theall
best.
Let’s look
the FFR’s.
1, 3 and
have
95’s but Big Brown’s TPR of 187 is higher than the
looking
at there
FFR's and
Brown
other horses.
Da’Tara
and TPR’s.
Ready’sAgain
EchoBig
should
not be
should
win…but
see
what
it
looks
like
in
the
PacePlus
considered because of their low FFR’s and TPR’s so
program.
Big Brown should win…but look at these 5 horses in
the PacePlus program.

Now go to Program Mode and click on PacePlus
which will take you to the PacePlus screen, then
go to race 11 and these 5 horses will be the only
ones shown in that race.
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Explanation about the Show Detail box will be
given when we explain the PacePlus section.
At this time I will tell you what I am doing and
give you examples. You will be able to
understand what I do so you can do the same
thing.
thing.

I have sorted in the Show Detail box by the Spd column. You can tell by the grey box around the 110. I usually start
with this column for my elimination, but only if I have more than 5 horses. Next I would sort by the R column since
this is a route race. I would eliminate the bottom horse. Then I would also look at the S column and maybe eliminate
the bottom horse. If it is the same horse in both columns then that horse would be taken away.
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Above is the race and the Show Detail box from the previous page. The Show Detail boxes
below are the different sorts I mentioned on the previous page. You can tell which column is
sorted by the box at the top of the column. The box is made of dotted lines (around the 110).

Since I did not eliminate a horse with the Spd column I would eliminate with the R column.
The horse at the bottom is…….Big Brown. I would also check the S column to see who is at
the bottom.

And who is at the bottom…….Big Brown. So at this time I would check his name in the Hide
horse box and eliminate him from the race.

1-54

Above is the race and the Show Detail box from the previous page. The Show Detail boxes
below are the different sorts I mentioned on the previous page. You can tell which column is
sorted by the box at the top of the column. The box is made of dotted lines (around the 110).

Since I did not eliminate a horse with the Spd column I would eliminate with the R column.
The horse at the bottom is…….Big Brown. I would also check the S column to see who is at
the bottom.

And who is at the bottom…….Big Brown. So at this time I would check his name in the Hide
horse box and eliminate him from the race.
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In the Hide horse box above you can see Big Brown is checked and then Refresh was clicked. Big Brown does not
show in the race above. Now the race shows 4 horses.
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Explanation about the Show Detail box will be
given when we explain the PacePlus section.
At this time I will tell you what I am doing and
give you examples. You will be able to
understand what I do so you can do the same
thing.
thing.
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You would click on the headers S, R, AR, Spd, PC, FFR, TPR and E the click on the 1 column.
The top 2 horses are 6 and 3.

Then click on the 2nd column. The top 2 horses are 3 and 6.

Then click on the 3rd column. The top 2 horses are 6 and 3.

So the 2 horses to bet to win would be 6 and 3.

Here is something for you to think about. This was a route race and the FFR and the TPR were used to handicap
the race. I have been looking at using the EPR instead of the FFR to handicap the race. I have been playing with this
idea and it seems to work pretty well. Look at it and see what you think.
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Race 11 results.
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Adjusted Call Time … Explanation
Click on the word Display and this
menu will appear.
The main feature of this menu is to
switch between the feet per second and
the adjusted times screen.
The All PP’s and the Check PP’s in
the header as another way to work
these options.

Click on the Clear button to
clear both filters and return
all horses to the screen below.

Click the x to
uncheck all the
checks in these
boxes.

When you click on this filter it
allows you to choose how you want
this page filtered. You can filter by
finish position 1, 2 or 3.
Choose the
race you want
to handicap.

1 x 0.5 means the horse won the
race by a half a length.
The 1st number is the position; the
2nd number is the lengths behind or
the lengths the horse won by.

x

When you click on the Dist. box
you will get the above pull down.
PP stands for Past Performances.
1 is the most recent PP and 4 is
the PP that is 4th back. Ten (10)
will give you all the horses PP’s.
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You can then choose the distance
that you want to look at and the
program will only show you that
distance.

Adjusted Call Time … Belmont…Race 5
Now I will go to another race to look at handicapping by distance. I have chosen again Belmont June 7, 2008. This
is a race where you will not pick the winner by using this program or any other program. Just looking at the
PacePlus program it will show you the winner but none of the ways shown to handicap will give you the winner.
Now I am going to use distance and final times to pick the winner. This is the process to use and in the end you
would bet the horses picked. After the race you would find you lost and if you go back to see why you would see
who you should have picked. So lets handicap.
This is an example of what you would see for race 5 on this day.

This page shows only the races that are 6F. As you can see I chose the 6F in the Select Dist box. To bring all
distances back go back to the Select Dist box and click on Dist. This will take away the filter for distance. The same
is true for Filter on Finish Pos. Choose the word Filter and it will take away the filter that you used.
Below are examples of filtering by distances of 6F and 6.5F.
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Above you have the 6F filtered by the 3rd finish position.

In the 6F you have 3 horses with a low finish time. The low times have red boxes around them. The 11 horse has a
low Spd rating so he would not be considered. The 8 horse has a better finish time by 3/5 so the 8 horse would be
my pick from the 6F. You could use the number 2 horse as your second pick or use the 4 horse at 6.5F. I would
probably use the 4 horse because his class is higher.

Above you have the 6.5F filtered by the 3rd finish position.

So my 2 picks would be 8 and 4.
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As I said you would not have gotten the winner. It is not that this program can not give you the winner it is because
the horse didn’t have the stats to show up in the program. No program that I have seen would have picked this
horse … but
To me there are three things that are important.
•

First is class. I see class different than other people and a lot of people say I am wrong. I believe class is
the level where a horse has won.

•

Second is the horse’s pace or in the PacePlus program it is the S (sprint or early pace) or the R (route or
late pace) column.

•

Third is the ability to win, in this program it is shown in the A column. The horse’s ability to win is
shown by an A.

You will see 3 different A’s and so you will know A+ is best followed by A and then a.
The APV column is something I never looked at because I felt that the highest class horse makes the most money but
it can show you a lot. These four columns have red square boxes around them. The running style column is
important. In the example below there are 4 front runners the 2, 7, 9 and the 1A. Only one of these horses has a good
speed rating, so the winner could come from the E/P horses.
Now with the information in the previous paragraph you should be able to pick the winner even if the program
didn’t.
Which horse would you pick as the winner?

Did you pick the winner?
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As you can see Endless Circle has the highest class and the highest APV. Then when you look at the A column
Endless Circle has an A+. As for the S column he is not at the top not even the top half. Three out of four is pretty
good.

Nothing works all the time but some things everyone should be aware of and look at while handicapping. You have
to look to see what is happening as well as running the program. The four things talked about should always be
looked at when handicapping.
Endless Circle paid $43.00 on a $2.00 bet. If you had just put a $10.00 to win bet you would have made $215.00.
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Feet per Second … Explanation
The track and date of the
race are shown here.

PP’s stand for Past Performances. With
this menu you can pick the number of
PP’s that you want to see for each horse.

With this menu you
choose which race
you want to view.

Here you are
shown the
distance and
date of the
race.
This filter menu lets
you pick the distance
of the PP’s that you
want for each horse.

This filter menu lets
you pick a PC value to
filter the PP’s of the
horses. PC is what
Dr. Sartin called his
Pace Class.

The Display screen is the way to go between
the Feet Per Second and the Adjusted Call
Times screen. The check mark tells you
which screen you are in.

This is about the 2 menu’s
you see on the left sides.
This is about the 2 menu’s you see
on the left sides.
PP’s allows you to chose 1, 2, 3,
4, and 10 Past Performances to be
displayed.
Race allows you to choose the
race you want to handicap.

1-66

Dist allows you to choose
the distance of the PP’s
you want to show on the
page.
Filter is to choose the PC
value that you want to see.

The Clear button will restore all
the horses and undo all filters
and selections that you have
made.

You can highlight a line by
clicking on some part of the
line. This makes it easier to
read across the line or to find
the box you want to check or
uncheck.

The Hide Below Avg will take
away all PP’s that are lower than
the average shown for the C2
column

The ReCalc button lets
you recalculate the
averages one more time.
After you use the Hide
Below Avg you can
recalculate a new set of
averages with the new
group of horses. This is
only if you want to. I
very seldom recalculate
the average.
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This is the File menu. It duplicates
the Clear, Close and the Capture
button. The Capture button is
inactive when grey. After you work
this section and are ready to get out
Capture will be black and you can
use it.

Hide below
The HideAvg
Below
Avgis
button
check box
is relater
related
to to
these numbers.
these numbers.

B
A
A. Clear. If you click on Clear it will take away all that you have clicked on or checked. It will bring back all the
PP’s and all the horses.
The X will check or uncheck the check boxes in front of the PP. If you want to select horses to keep and
continue handicapping look at the number you want to keep. If you want to keep more than you want to get rid
of click the X and it will check all the boxes. Now you can uncheck the PP you do not want. If you are using C2
to eliminate PP’s you can highlight the line to make it easier to find the box you want to uncheck. Then click on
Select and it will keep the horses checked and eliminate the rest. If you want to get rid of more horses that you
want to keep then you can use the X to clear the boxes if they are checked. Then check the ones you want and
click Select. If you want to see the screen you had before you clicked Select, then click All.
B. This about the Display area. There are two parts to Display. The two parts are All and Selected.
If you are eliminating PP’s you can highlight the line to make it easier to find the box you want to uncheck and
uncheck the box. Then click on Select and it will keep the horses checked and eliminate those unchecked. If you
want to see the screen you had before you clicked Select, then click All.
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Here we have created an
average of 6 columns F1, C2, F3,
SP, Fx and Dec.

1

Races that are equal to or better
than the average have a + in the
far column to the right.

2

These + races are then shown in
Print Preview in column C.
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Below is a brief description of
each column in the red box.

F1
F2
C2
F3
HE
AP
EP
SP
Fx
Dec
%E
PC

1-70

The first fraction.
The second fraction.
The average of F1 + F2.
The third fraction.
The average of F2 + F3.
The horse’s average pace.
The horse’s early pace.
The horse’s sustained pace.
The average of F1 + F3.
Deceleration number.
% of energy used in early part of the race.
Horses pace class.

Feet per Second … Breeders’ Cup…Race 2
This is what the screen looks like.

Click here.

This horse has no
USA races so there is
no past performance
information to show.

This horse has no
USA races so there is
no past performance
information to show.

Horses 2, 4, 7, 8 and 11 have blank spots in their Past Performances; this is because these races were not run in the
USA. With the information given in the file that is downloaded the only information we can provide is the AP
(average pace). Now I will handicap this race. With the large number of PP’s, that are on this page you would click
on the Hide Below Avg. This will eliminate past performances and sometimes horses that will not be good enough to
compete in this race.
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This is the page after we selected the Hide Below Avg. Now look at the PC column, most of the numbers are high
numbers. Some columns show numbers around 106 to 111. If they are low numbers with a wide spread I do not use
the Filter on PC value. In this case because the numbers are high, not a wide spread and there are still a lot of past
performances I will filter using the Filter on PC value.

When you click on the Filter on PC value control you get a drop down menu. I usually click on the 4th number down
which in this case is 118. It will then eliminate every thing below 118. The examples on the next page are PP’s that
are 118 or better.
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At this point you can filter by the Dist or go to the Adjusted Call Times screen and filter by the Dist.
In this example I’ll sort by the Dist at this time. Example of page after filtering follows.

At this time click the X and then the Capture button is now available.
Now you can click Capture and Close then you can go to Print Preview
and these 4 horses will be in the 2nd race. All other horses will be
eliminated. You can then continue handicapping these horses.
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After you click Capture and Close and then go to Print Preview you will get the following page.

Bring down the Show Detail box. Now click the headers S, R, AR, Spd, PC, FFR, TPR and E. Next sort the 1, 2, and 3
columns. When you have clicked on a header if the column does not count it will not add a number. The columns
that do not add to the count are the %E and the Mu. When you have clicked on a column that adds a number to the
count and then re-click that same column it will not add a number to the column a second time.

You will notice that in columns 2 and 3 horses 13 and 12 have numbers that are the same.
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Click Save to save the numbers in the
Show Detail box to the Print Preview page.

We will continue handicapping.
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Looking at columns 1, 2, and 3 (in the red box) you can see which two you would pick. Column 1 would be 10 and
13. Column 2 would be 10 and either 12 or 13 since they both have a number of 24. Column 3 would be 10 and
again 12 or 13 since they both have a number of 36. Looking at 12 and 13 who is better? Looking at column S 13 is
better (162.4 compared to 161.3). Looking at speed 13 is better. Looking at PC 12 is better. Looking at APV 13 is
the best horse so column 3 would be 10 and 12.
So your 2 horses to bet would be 10 and 13 but is that correct?

But….
There is another way to look at the race.

I have blocked out the columns that are not used for this evaluation. The columns that are left are the most
important. Since I am looking for 2 horses to bet I would pick the 2 highest numbers in each column. In the Class
and the C column all horses are equal so none are picked. After picking the 2 highest in each column count the boxes
for each. You would have the following
•
•
•
•

Horse 10
Horse 13
Horse 12
Horse 9

3 boxes.
3 boxes.
2 boxes.
4 boxes.

Now you have horses 10, 13 and 9
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Because this horse has only1 box, I would eliminate this horse.

The horse to bet would be the 9 horse. The second horse would be the 10 or the 13. I would take the 10 over the 13
because the 10 has the higher speed rating, PC number and the higher running style. So the pick would be the 10 and
9 horses to bet.

Race 2 results.
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Mu… … Breeders’ Cup…Race 3

This is the 3rd race from the Breeders Cup that ran Oct. 25, 2008 at Santa Anita. We are
going to handicap this race showing you a way to use the Mu column.
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1
I have brought down the
Show Detail and the Hide
horse box. I have sorted
the Show Detail box by the
Mu column.

2
The Mu column is new, it was put in the
program late in 2008.You need to look at this
for yourself and decide how valuable it is. This
is what I have found out so far.

3
Check the boxes of the horses that
you want to eliminate. Click
Refresh and the program will
update as shown in the example on
the next page.

The winner usually comes from the area that is
in the green box. This area should be 0’s, 1’s
and if necessary 2’s. Start with 0’s and 1’ to
see if you have 50% to 60% of the horses. In
this example the green box has horses that are
0’s and 1’s and is a little over 58% so you
would not use the 2’s. The red box has all the
horses that have speed ratings that are over
100. Looking at the 5 and 9 horses with speed
ratings of 99 I would eliminate them. The
winner should come from the red box area. As
you know in horse racing what you think
should happen doesn’t always happen. The
winner in this race was number 7.
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1

2

Mucolumn
Looking at the
youyou
cancan
Mu column
see that we have the 5 horses that
were in the red box. We need to
eliminate at least one more horse.
Spd
Look at the
column
column
andand
youyou
Spd
will find that the number 2 and 4
horses have the lowest numbers so
I would eliminate these 2 horses.

Check number 2 and 4 in the
Hide horse
box.
box.
Click
Click
Refreshtotoeliminate
eliminatethe
the2 2
horses.
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After clicking Refresh you will have this page. Click on each headerS,S,R,R,
AR, Spd, PC, FFR, TPR and E.
E. Looking
Lookingatatthe
the1,1,22and
and33columns
columnsyou
youwill
will
find that the horses stay in the same order. Your 2 horses to be
t would be the
8 and 7 horses.
You would click Save
toput
putthe
thenumbers
numbersthat
thatare
arein
inthe
theShow
boxonon
Saveto
ShowDetail
Detailbox
the Print
PrintPreviewpage.
Preview page.

2
Program
Now click on Program
Mode, then Display/Print
Display/Print
and then User
Usercustomized.
customized.
For more information
see the User customized
section.

1
Click on Capture and then on
OK to save this in the User
Customized section.
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Since you want 2 horses then I’ll look for the 2 highest numbers in each column. In columns where 2
of the 3 numbers are the same I did not put squares. Now as we have done before lets count the
squares.
Horse 8 has 3 squares.
Horse 7 has 4
3 squares.
Horse 1 has 2squares.
So the bet would be the 8 and 7 horses.

Race 3 results.
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Examples of the Mu column.

The red box is 35% of the horses. If you
included the 5 and 14 horses then you
would have 50% of the horses. I would
not use more than 50% of the horses.

Winners are
high lighted.

The red box contains more
than 60% of the horses. With
only one 0 and 1 you have to
include the 3’s. The number 1,
5, and 3 horses have low speed
ratings so I would eliminate
them.

The red box is only 40%of the horses and
because of the number I would not add more
horses.
As you can see the winner is in the red box,
number 3.
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The red box contains
50% of the horses.
40%

The winner is
high lighted.

Remember the Mu column does not always work. You need to check the race on the Print Preview page. As you
look at the 4 horse in the Print Preview page you see that My Echo is the number 1 pick by Brisnet, is the highest in
the S column and has the highest class. My Echo has an a in the A column, a plus in the C column and is the highest
in the APV column.
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Miscellaneous
To Find What Wins
After every race you need to look at the race to see what is winning. There are two different ways to do this.
The first way starts by printing all the races. Then you need to highlight each winner of the race. In the example I
put a red box around the winner because I could not highlight the winner. You can take a yellow highlighter and
highlight the winner. Look at the highlighted area to see what the winner has that the other horses do not.

Below the example will show you 7 columns to look at because 4 of these columns are not looked at and sorted by
the program. These columns are important. The columns in the Show Detail are also important.

The second way to see what wins is explained and are examples given below.
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Take any race day and open Print Preview in PacePlus. Then open Hide horse and put checks in all boxes except the
winner. Then click Refresh. Look at race 1 and then go to the next page.

1-86

Now look at race 1 the winner is the only horse showing. Do this to all the races for that day.
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The next two pages show you what the race will look like when you are finished.

Track Profile.

Track Profile
The red box contains Track Profile information. To obtain a Track Profile you click on Database which is found on
the yellow page and using the Database you input the winners of a race. This information from the races you enter
will then create a History feature which is used by the program to make the Track Profile.
For details of the History feature refer to the technical section of the manual on page 2-17.

1-88

If you set up your results right then you can
use the Get Results, shown to the right, to
acquire the winners and make pages like the
two above.
This will allow you to view what all the
winners have in common. One thing I see is
that most all of them have an A in column A.
You can also compare them to the track
profile if you have been keeping a database.
Some tracks I have found the database to be
good and others not so good.
Where there are no track profile it means that
no races at that distance have been run at
this track at this time.

Add that on 7 thru 8F races 4 out of 5 have a plus in the B column.
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Section 2 - Operation
PacePlus Overview
Following the design intent of Pace Evaluator, PacePlus is designed to be as simple to use as possible. With the
number of features incorporated into the PacePlus program, this is a daunting task while trying to keep the manual
as short as possible and yet provide a comprehensive explanation of the program’s controls and features and how to
access and use them. The PacePlus program incorporates the original Pace Evaluator program functions with some
enhancements. In addition, it provides a number of new features.
Database A feature to maintain a data base of averages of several data fields used by the program and displaying
and printing these values at the top of each race in the PacePlus preview and print products.
Pace Lines The program also provides a Pace Line display for each race along with a possible pace of the race. This
is a simple pace line presentation derived from our reading of Dr. Sartin’s works. We implemented a simplified
version of the pace line which is displayed with the opening screen from the Show… menu.
Feet per Second Pace Data From Dr. Satin’s research, there is a screen which displays the Velocity data in
Feet/Second. This data gives the velocity figures for the 3 fraction calls, the second call, average pace, early pace,
sustained pace, etc.
Adjusted Call Times The program also calculates and displays the adjusted call times and displays the position and
lengths back at each call.
Filtering In the Feet per Second and Adjusted Time screens, the user has the ability to filter on the distance of the
PP’s presented in the displays. The user may also filter on the Finish position when in the Adjusted Time display
and on the PC value when the program is in the Feet per Second display. When the filters are applied, the data is
filtered on as many of the filter options as the user has selected. For example, if the user has chosen a distance of 6
furlongs, a PC value of 110 and a finish position of 2nd, the program displays PPs which meet the conditions of: 6f
and a PC value equal to or greater than 110 and a finish position of 1st or 2nd.
Scratch The PacePlus program provides a tool to permit the user to apply scratches to the race. The purpose of the
scratch is to remove a scratched horse from the program products. You can go back and restore the horse if needed,
e.g., a horse was erroneously scratched.
Hide Horse A separate feature allows the user to remove or restore a horse without making it a scratch. This allows
the user to temporarily remove or restore information for a given horse on the day’s program.
Both scratch and hide horse affect the Pace Evaluator display, the PacePlus display and the print products.
Show Detail This feature supporting the PacePlus functions allows the user to display the details of a PacePlus race
and gives the user the ability to accumulate some comparative data and sort the data by several data fields.
Contenders We developed a proprietary method of selecting contenders. The final method was chosen from several
based on selecting the winner as one of 4 contenders in at least 60% of the time.
Results PacePlus includes a capability to read and display certain results information downloaded from the web.
This feature was developed for those who retain historical records and include the results as part of that record.
PacePlus opens the results window in two places, the History window and the Print Preview window. The Results
feature supports a limited number of input formats.
Race Condition The program also allows the user to display the race condition information in a separate window.
Recommendation The number of features available and the application to the analysis process provide a wide array
of potential analysis tools. The user must work with the numerous tools and determine which tools best fit his
handicapping methods and provide the best results.
Most likely, users will not employ all the available tools, each user will find a tool or group of tools which serve him
best. This will take some experimenting to become familiar and comfortable with the tools and to gain confidence in
the results they produce.
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Using the PacePlus Program
The PacePlus program is designed to be as intuitive as possible. When the program opens, a clean window is
displayed. The program has five command buttons in this window (see PacePlus Menus image on page 2-5). Four
are visible and one is hidden in this image. The PacePlus program contains the same functionality as the original
Pace Evaluator program with some additions. For specific details of the Pace Evaluator program operation, please
refer to the Pace Evaluator manual included with PacePlus.

Program Directories
The PacePlus program establishes a set of directories at installation which it uses to store the various files used by
the program and the user. These directories established by default are shown on Page 1-1 under the topic Program
Download. If the user needs to see the list of directories and their contents, they are listed in the manual but the user
may also display them from within the PacePlus program.
To display the actual directories for your system, select the Show … menu and choose the Directories option. If you
want to know where PacePlus is looking for the files it uses, this display shows you.
If the user has opted to use the default directory installation options, the program presents a new window which
shows the installed directories as shown in the image below.

Default Directory Structure
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If the user has opted to use other than the default directory installation options, the program presents a new window
which shows the installed directories as shown in the image below.

User Selected Directory Structure
The image below demonstrates the case where the user also uses the Brisnet Custom PP Generator software and
has chosen to have PacePlus look for zip files downloaded in the C:\PacePlus\BrisDownLoad directory. This user has
chosen to continue to use the D:\BrisCust\Data directory as the location to store the data files extracted from the
zipped download.

Using Custom PP Generator Directory
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For users who have downloaded the data files from Brisnet or TSN Horse into BrisDownLoad and the automatic
unzip feature of PacePlus has extracted the contents of the zip file, the download zip files are moved to an archive
directory and renamed. If this directory does not exist, the program creates it when the first download file is
archived.
The PacePlus Directories (Archive) image below shows the directory structure when the archive directory exists.

PacePlus Directories (Archive)

Program Menus
The program has four menus; the File menu for file access, the Show … menu to display various options, the
Database menu which opens a window allowing user use and maintenance of the history files and the About menu
which gives information about the program version and our web site and email address.
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PacePlus Menus

Program Controls
The program provides a menu option corresponding to each command button and two menu options without
corresponding command buttons. The image below shows the File menu with its options visible. The options on the
menu not provided by a command button are: open a downloaded zip file [Uncompress [unzip] file] to uncompress it
and to remove old files [File Cleanup].

The Print Preview button is not displayed until a data file has been opened, i.e.,
until the user has selected data that may be printed. Likewise, there is a File menu
option to print preview the current race day’s data but again it only is available
when data has been loaded from a race data file.

The Quit button ends the program as
does the File menu Exit option.

PacePlus User Controls
The Show … menu has six options in addition to the Directories option discussed at the beginning of this section.
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Manual

PacePlus Show Menu
The Manual option displays the PacePlus manual in Adobe© Acrobat Reader. In addition, there is a button labeled
Manual at the lower left of the window which allows the user to display the manual without accessing the menu.
The Racing Form option allows the user to open your racing form downloaded in the PDF format with Adobe©
Acrobat Reader; the ReadMe file option displays the PacePlus ReadMe.doc file and the Pace Forms option displays
the Adobe file containing the PacePlus forms provided with the option of the user to print any or all of the forms.
The Pace lines and FPS/Time options are described below.
Manual or Forms Display. If the program cannot display the selected manual, the most likely problem is that the
file is missing [it has been moved or erased] or there is no program installed to display the Adobe© pdf files. The
program needed is the Adobe© Acrobat Reader, a free program which allows anyone to open, read or print a file
produced by Adobe© Acrobat.
If the selected manual file cannot be found in the installation directory, the following error message is displayed (see
images following). The solution to this problem is: either copy the manual from the distribution CD into the
directory where PacePlus is installed [normally C:\PacePlus] or use the Manual Reinstall option from the distribution
CD-ROM. The specific file for the missing manual is identified in the Missing Manual image below.
Similarly, if the pace forms file cannot be found a message is displayed informing the user how to recover the file.

Missing Manual
If no program is installed to display the pdf files, the program displays a message informing the user of this
situation.
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Acrobat Reader Not Installed
In this case, the simplest solution is to install the version of Acrobat Reader supplied on the distribution CD located
in the Acrobat directory. The user may also download the most current version of the Acrobat Reader from the
Internet.

Uncompress [unzip] file
This option is left for user experimenting if desired but is not likely to be used. When PacePlus starts, it looks for
new zip files in the specified directory and extracts the contents to the specified directory. These directories by
default are C:\PacePlus\BrisDownLoad\ and C:\PacePlus\DRFData\.
To accommodate a user who may accumulate a historical collection of data files, PacePlus renames the files
extracted from the download Zip file and renames the Zip file itself following the extraction when it moves the file
to the archive directory.
The Zip file downloaded typically has a name like APX0602k.ZIP and the file stored within the Zip file is
APX0602.DRF. If a user accumulates a multi year collection of files, it is inevitable that some files will share a
name with a prior year’s files and the prior copy of the file will be overwritten.
To preclude this eventuality and to facilitate the user collecting files over multiple years, when a DRF (or MCP, PCS
or EG) file is extracted from the zip file, it is renamed. Using the above example, the file extracted, APX0602.DRF
is renamed by PacePlus to Apx20080602.drf. Likewise, when PacePlus moves the zip file to the archive
directory, it renames the zip file as Apx20080602k.zip. The extracted data files retain the original file name
extension, e.g., a PCS file extracted from the zip file retains the .pcs file extension after renaming.

Import Data
The PacePlus program must import data from the file downloaded from one of the specified sources. The File menu
Import Data option or the Import Data button initiates this process.
Clicking the Import Data control displays a dialog box in which the user selects the file extracted from the download
source.
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1
When you click on
Data Import…..

3

2
…. This box will appear.

Click on the file desired to
handicap….
the name will be shown in
the File name box….
Then click Open.

Selecting a Race File
Clicking the Open button causes another file dialog box to appear. The example is shown on the next page.
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Save the PacePlus Data Files
If this file name is okay, click the Save button or change the file name to that desired and then click Save.

Import File Path Error
An error that can occur is PacePlus cannot find the path on which it expects the source file for import to be found. In
this case the Open Source file dialog box does not show a file name or the file type to be opened, but instead shows
the entire path to the desired destination in the File name: control and highlighted (see the Import Path Not
Found image below).
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Import Path Not Found
If this indication is observed, the user can correct the situation by either of two actions.
One action is to create the directory structure as identified by the highlighted text. In this example, on the E: drive,
the program is looking for a directory named DRFData. This directory is in a directory named PaceEval which is
itself in a directory named Horse Stuff. This action is appropriate when the specified file path is correct and has been
deleted.
The alternate action is to navigate to an existing directory in which the source files are located. This action is
appropriate when the specified path is no longer desired and a new path is desired, e.g., the original path was
renamed.

Extract Progress
Because of the volume of data extracted and some preprocessing, the Import process may take several seconds. To
show the user that the import process is continuing, a progress bar is displayed in the lower portion of the PacePlus
window.
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PacePlus Import in Progress
When the import process is complete, the program returns to the opening screen waiting for the next user action.

Selecting Import File Type
PacePlus will extract data from any of four file types downloaded. If the file from which data is to be extracted is not
a drf data file from Brisnet, the user identifies the file type by selecting the appropriate file type using the Files of
type: list in the dialog box

Paceplus will extract data
from any of the four types
of downloads.

Select Source File Type
When the user identifies the desired file type, the dialog box list is updated to reflect those files as shown below.
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Listed Files of Selected Type
Once the user selects a different type file and executes the import action, the program remembers the selected type
for future import operations.

Open Race File
Once the import process is done, the user opens the race file and uses the PacePlus program to aid in his
handicapping of a race.
To open a race file, click on the Open Race button or the File menu Open Race Data File option.

Open Race File
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PacePlus displays a file selection dialog in which the user selects the desire file by clicking the name and then
clicking the Open button of the dialog box.

Error Checking
In order to prevent a program fault resulting from an error in the data import process or the inadvertent erasure of a
file of the file set for a race, PacePlus checks for a corrupted file set when the user selects a race to open.
If the program detects a problem with the file set, it displays an alert message for the user as depicted in the Corrupt
File Set image below.

Corrupt File Set
When the user clicks OK to close the dialog box, the program erases the remaining files of the set in preparation to
import the race again and to remove a bad file set from the Open file options.

PacePlus Data Display
When the user opens a race file, the information can be displayed on the initial PacePlus screen. The race selected is
displayed in the window’s Title Bar, the blue band across the top of the windows. In this example, the race is for
Arlington Park June 7, 2006.
Select the race from the Race selector and then select the desire horse from the Horse selector.
The program displays the information for the selected horse. At the top of the window (above the blue line) the race
number, race distance, selected horse and the race class are displayed.
Details for the selected horse are displayed below the blue line for as many as ten past performances (PP’s).
PacePlus collects data from PP’s of 5 to 12 furlongs inclusive. A PP may be discarded if the data in the file is
invalid, e.g., some data required for the calculations is missing or duplicated.
Occasionally such errors exist in the files downloaded.
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PacePlus Data Display
The Finish Æ By columns indicate the finish position and lengths back in red or lengths ahead in black indicating
the horse won this PP. A yellow background indicates the horse finished within 5 lengths of the winner for PP’s not
won.
Below each column for EPR, FFR and TPR, the average for the number of PP’s displayed is also shown. Below
each call position column is a count of the times the horse placed 1st or 2nd in the PP’s shown and the percentage is
shown below the Æ By column.
If there are no PP’s in the 5f to 12f range, the program displays a message indicating so as below in the area where
PP data would be displayed.

No Data
Similarly, if the horse has not raced in the United States, no pace data can be computed and similarly, a message is
displayed indicating this status (example below).
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No USA Races

Pace Lines
When the user opens a race, the Show … menu option Pace lines is available (see File Open Options image below).

File Open Options
Selecting the Pace lines option provides the display of pace lines for the selected race as shown below (see Pace
Lines Display image).
When the Pace Line display is shown, the race shown in the pace line display is the same race as displayed on the
base window. Selecting a new race on the PacePlus window will cause the Pace Line display to update to a new race
selection.

Pace Lines Display
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Clicking on a column header in the Pace Lines control will sort the values on that column. The Pace of Race line
always remains at the top of the display.
To remove the pace line display, click on the

control.

History (Database) Function
PacePlus provides a means of saving historical data for races handicapped. The user activates the History feature by
clicking the Database menu option. When activated, the program displays the History window as shown below.
When the History window opens it defaults to displaying the contents of the history if one exists (see History
Display Function image on page 2-17). If no history has been accumulated, the history window opens a blank
window as shown below.

History Window Display
The History window has four user controls (or buttons) across the bottom of the window. These controls are
duplicated by menu options illustrated in the History File Menu image below. The menu provides an additional
option, About, which displays a brief description of the History feature.

History File Menu
The controls and corresponding men options provide the functions described below.
The About menu option displays the window below giving a brief description of the history data saved.
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About History
Close. This option closes the History window.

Display History Data
Display. This option displays the information currently stored in the history file. A sample history file display is
shown in the History Display Function image below.

History Display Function
Track Profile. The data displayed in the image above shows the track ID, in this case Arlington, Aqueduct and Belmont.
The level column indicates race levels we have used so that the different race levels will not be mixed together.
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Level 1 is Grade 1, 2, 3, Stakes and Allowance races.
Level 2 is high claiming races down to $20,000.
Level 3 is $18,000 claimers and down, MdSpWt and all other Maiden races.
The distance is stored by levels to facilitate displaying the data in the print preview.
The number of samples (see History Display Function image on the preceding page) shows the user how many
races of this distance and level were used to computer the average values stored. The fewer samples used to produce
the track profile, the less valid the profile data. We suggest a minimum of 8 to 10 samples per track entry1 be
accumulated before placing significant weight on the Track Profile numbers.
In the example shown in the History Display Function image, the first 3 AP (Arlington Park) entries are based on
one data sample.
The fourth AP entry is based on 3 data samples and the first BEL (Belmont Park) sample near the bottom of the
image is based on 5 samples, i.e., results of 5 races at level 1 6f have been entered into the history database.
The S and R columns are data calculated for a Sprint race or a Route race using Dr. Sartin’s velocity (feet per
second) method.
AR is an abbreviation for Ability Rating and is a proprietary computation based on various factors from past
performances.
The Spd column is the Speed Rating of the winning horse.
The PC column is using Dr. Sartin’s method to figure the horses Pace Class for the race.
The Epr/Ffr field contains the EPR value if the race is a sprint (distance less than 8f) and the FFR value for a route
race (distance of 8f or greater).
The Tpr field is saved for all history records.
The values stored in the file are averages of the data accumulated for each of these data fields. The data when
available is displayed or printed in the header of the PacePlus preview and print products for the user’s comparison
as desired. Return to referring link on page 1-88.

Deleting History Data
Delete. This option allows the user to delete information from the history file. An example is shown in the History
Delete Function image below. By default, the history delete function defaults to deleting race history data by race
day. The display is sorted by track code and date.
Note in the image below that the Arlington and Aqueduct tracks are not in alphabetical order. The sort is by track
code (not track name). The code for Arlington Park is AP and for Aqueduct is AQU thus causing the sort by track
code to put Arlington before Aqueduct.

1

An entry is a sample at the same track, distance and level.
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History Delete Function
The user options for delete are to delete all history data or to delete history data for a selected track and date or range
of dates. To delete information for a specific track and date range, check the box for that selection. When at least
one delete selection is made, a
control is visible in the upper right of the control as shown in the Delete
Data image below.
The user may opt to delete a specific day’s information or a year’s information for each track by selecting the other
Delete by: options. When the user clicks the Day option, the display is updated to show the new options as show in
the Delete by Day image at the bottom of the following page.

Delete by Day
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Note in the above image, the Day column now gives the date of the race for the user to select. As many as desired
may be selected. Selecting an entry removes all history data for the day(s) selected.
To remove greater amounts of history data, the user may opt to delete data by track and year. By clicking the Year
option, the display is updated to show the new options as show in the Delete by Year image below.

Delete by Year
Note in the above image, the Year column now gives only the year for the user to select. As many as desired may be
selected. Selecting an entry removes all history data for the year(s) selected.
In the example below, two races are selected for removal, Aqueduct, NY, for April 11, 2007 and Belmont Park, NY,
for May 12, 2007.

Delete Data
Clicking the
control causes the program to delete the data for these tracks for the dates specified, update
the display and hide the
control. The result of this action is shown in the Deleted Data image below. Note
the Aqueduct race for April 28, 2007, and the Belmont Park races for May 10, 2007, and June 7, 2008, remain in the
history database.
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Deleted Data
Select file. This option allows the user to select the race to add to the database. When the user selects this option a
file dialog box is presented for the user to select the data file for the race to be added to the history file. Once the
user selects a data file, the history windows also opens the Results window positioned to the left of the History
window and the races are sequentially cycled through the History window display allowing the user to identify the
winner of the race or skip it, i.e., omit it from the history file.. This is illustrated in the History and Results
Windows image below.

History and Results Windows
By opening the race results file downloaded from one of the web sites in the Results window, selecting the winner is
fairly well facilitated by having a capsule display of all winners immediately adjacent to the history window. When
the user clicks on the winner, a message box is displayed asking for confirmation of the winner selected (illustrated
in the Winner Selected image below).
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Winner Selected
Clicking Yes confirms the selection of the winner and the next race is presented for the user to select the winner.
When the winner of the last race is identified, the program presents a summary list of the user’s identified winners
for confirmation as shown in the Confirm Winners image below.

Confirm Winners
Note that in the above image that only 11 horses are visible yet there were 13 races processed. The user may move
the message box down to see all winners listed when it partially covers the list. If the user has opted to skip a race,
the horse name is not displayed but instead the word “Skip” appears in lieu of the horse name.
Clicking
to the history file.

to confirm the list of winners as shown directs the program to add the information for this race

causes the program to discard the info and return to the basic history window leaving the
Clicking
Results window open.
If the user closes the history window, the results window is also closed.
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Confirm Winners with Skip
The Confirm Winners with Skip image above illustrates the case when a user elects to omit a race from the history
file. Note above that Race 3 does not have a winning horse identified. In this case, when the user confirms the
winner list, data for all races except those marked Skip are entered into the history file.

FPS/Time Window
PacePlus provides a display showing velocity data or the adjusted times for each PP for which all the data to do so is
available. By clicking on the FPS/Time button or the Show … menu FPS/Time option (see PacePlus Data Display on
page 2-14).
When the FPS/Time window is displayed, the user actions are implemented via control buttons, check boxes and
menu options. The menu options duplicate most of the button controls. The menu options are illustrated in the
FPS/Time Menus image below.

FPS/Time Menus
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The File menu options duplicate the

,

and

control buttons.

The Display menu options duplicate the
and
buttons and the
check box controls.
The Ft/Sec and Times options allow the user to select the display mode for the FPS/Time window. A check mark
beside the menu option indicates the current mode. In the example, the window is in the Ft/Sec display mode and
the All PP’s checked indicates the window is presently displaying all available PP data.
Display modes may be selected using the mouse or by the keyboard. Pressing the Ctrl & F keys simultaneously
switches the program to the Ft/Sec display mode and the Ctrl-T combination switches the window to the Adjusted
Call Times display mode.

Selecting PP Data
In the FPS/Time window, the user may select the number of PPs the program will display for his use. The program
defaults to 10 PPs, the maximum possible. If there are less than 10 PPs the program will display as many as are
available.
If the use selects less than 10 PPs, PacePlus always displays the most recent PP data, e.g., if the user selects 1 PP,
the program displays only the most recent PP data.

PP Selection
The user options available are 1, 2, 3, 4 and 10 PPs. The PP Selection image below shows the pull down list with all
options. When the PP selection is changed, the program updates the display to reflect the new value.

Velocity Data
Clicking the
opens a new window which initially defaults to the Velocity (FPS or Feet per Second) display
of information computed based on Dr. Sartin’s calculations of velocity (see Velocity Display image on next page).
On subsequent displays, the window defaults to the most recently selected mode.
These calculations provide the fraction velocities in feet/second, the second call velocity and several of Dr. Sartin’s
other figures calculated from these including Average Pace, Sustained Pace, Factor x, Factor w, etc.
When the user opens the FPS/Time window and has selected a race in the PacePlus window, the FPS/Time window
opens the same race and displays the race data using the last selected mode, i.e., Feet per Second or Adjusted Call
Times. If the user has not selected a race, the FPS/Time window opens with no race displayed.
The user selects a race by the Race drop down control in the same fashion as on the PacePlus window.
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Velocity Display
When the window displays the Feet per Second data, the program calculates and displays a set of averages for
Fraction 1, Call 2, Fraction 3, Sustained Pace, Deceleration and the Factor x or Factor w columns. The averages are
displayed above the corresponding columns. Those columns for which no average calculation is done display a
blank field.
check box. Clicking this control so it is checked
Above the data display the program provides a
causes the display to not display PPs with a second call velocity below the average for the C2 column (see Hide
Below Average image on next page).
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Hide Below Average
control is checked (as at left), the program displays a
button. The
button
When the
allows the user the ability to recalculate the average values again based on the currently displayed PP data. Once the
button is removed disallowing further recalculation of the averages.
recalculate option is executed, the
The new average values are displayed in place of the initial average values and the display is updated to remove
from the display all PPs having a Call 2 velocity less than the newly computed average (see Recalculate Averages
image below).

Recalculate Averages
checkbox (as at left) cause the display to resume the display the selected PPs and
Unchecking the
to restore the original average values calculated based on all available PP data.
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Adjusted Times

Adjusted Time Display

Manual Selections
The option to manually select a horse or group of horses from the FPS/Time screen and have that be the selections
the user handicaps in the Print Preview screen is also available.
To select a horse manually, the user clicks the checkbox so it is checked. Once at least one PP is checked, the
Selected command button is enabled allowing the user to view only those PPs specified by the checkboxes. Clicking
the Selected button tells the program to conceal all PPs which are not checked (selected by the user). Clicking the All
button restores the display of all horses meeting any filtering criteria set by the user. This allows the user to
manually select addition PPs if desired.
In the example on the next page, note the checks beside the PPs for horses 1, 2 and 3. In this case, the 6.5f PPs are
checked and the 6f PPs having the highest Call 2 Feet per Second values (see Manual Selection image on the next
page).
Also note that in the Display control group at the top of the window, the Selected and Capture buttons are now
enabled (not grayed out).
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Manual Selection
Display Selected. Clicking the Selected button produces the result displayed below in which only the PPs selected
by the user are displayed (see Selective Display image below).

Selective Display
Note that in the above image, the PPs are the same as those selected by the user. The PP dates are the same dates as
the PPs specified by the user in the Manual Selection image.
Selection may be made in either the FPS or the Adjusted Times display mode as best suits the users method of
handicapping.
Display All. Clicking the All button in the Display group reverts to the display shown in Manual Selection image
above allowing the user to select additional PPs if desired.
Capture. Once the user has a specific set of PPs chosen, these may be chosen to carry over into the Print Preview
button. Clicking the
button does not cause any change
function. To invoke this selection, click the
is what is displayed. It effect is not apparent until the user opens or refreshes the Print Preview.
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Filtering
The option to filter (eliminate certain PPs) is facilitated using Distance in both display modes, the PC value in the
FPS Display mode and the Finish Position in the Adjusted Times display mode. If multiple filters are selected, the
filtering effect is cumulative, i.e., the PP must meet the criterion of each of the 3 possible filters to be displayed.
If the user selected a PC value on which to filter and switches from the FPS display to the Adjusted Times display,
the PC filter criterion is still applied. Similarly, if the user selects the Finish Pos filter in the Adjusted Times display
and switches to the FPS display, the finish position filtering is still applied.
The Filter Selectors image below shows the three filter selector pull downs. The Dist filter is available on both the
FPS and Adjusted Times displays. The Filter on Finish Pos is available only on the Adjusted Times display and
the Filter on PC value is available only on the Feet per Second display.

Filter Selectors
The Dist filter pull down initially shows only the values down to 8.3, 8.5. To get the other options, simply scroll
down to the desired distance. The Dist filter values are fixed.
The Filter on Finish Pos pull down always shows 1st, 2nd and 3rd as the filter values. Selecting a finish position
filter value removes all PP’s having a finish position behind the selected position.
The Filter on PC value pull down is populated with 7 values calculated based on the race chosen. The high PC
value in the filter list is the high PC value in the data file for this race. An additional six list entries are calculated
from this initial value. Selecting a PC filter value removes all PP’s having a PC value less than the selected PC
value.
Sample screens of filter application are not shown here for space considerations. The user is encouraged to
experiment with the filter options and observe the filtering results.
To remove a filter criterion, select Dist or Filter in the applicable pull down list. If both filtering by PC and finish
position is selected, both must be removed by separate user actions, i.e., when in the FPS display, removing the PC
filter will NOT remove the Finish position filter value.
Clicking the
current race.

button will remove all filtering as well as restoring all other setting to initial conditions for the

Anomalies
During the development of PacePlus, we noted a couple of anomalies. One is in the performance of the tool used for
the FPS and Adjusted Times displays. This glitch is illustrated in the FPS/Time Display Anomaly image on the
next page.
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FPS/Time Display Anomaly
In the display when a field is blank, occasionally the blank filed will display a partial image of the data from the
field above. No program fix has been found for this issue but this anomaly is cleared by minimizing the window and
restoring it or by scrolling the data out of view and then back into view if this proves an unwelcome distraction.

Custom PP Generator Data Anomaly
Another anomaly is illustrated between the data displayed on the FPS/Time display and the Custom PP Generator.
This anomaly was discovered when testing the program with the Belmont Park race for June 7, 2008. In race #2,
Seeking No More has the most recent PP from a race on 17 May 08 at 2-3/8 miles (19f).
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In the image above, the most recent PP (17May08Mal) shows a finish call time of 8:39-4/5 in the Custom PP
Generator.
Looking at the adjusted call time in PacePlus, the finish time shown is 10:46-2/5. Initial reaction was that this
resulted from adjusting the finish time for a finish position of 9th by 32-3/4 lengths. The realization came that the
adjustment to the time could not be 2 minutes and investigation of the conflict was pursued to see if PacePlus was
calculating something incorrectly.
The data imported from the Brisnet Download File (DRF) had a time of 639.99 seconds for the finish call time for
this PP. A time of 639.99 seconds calculates to 10 minutes 39-4/5 seconds so PacePlus is in fact giving the correct
time and the Custom PP Generator an incorrect time. Adjusting the finish time for the 32-3/4 lengths behind adds
6-3/5 seconds which results in a true adjusted finish time of 10:46-2/5 (see FPS/Time Data Anomaly image below).

FPS/Time Data Anomaly

Print Preview and Printing
Once the user has opened a race file, note the Print Preview button is visible at the bottom of the window and there is
also a Print Preview option displayed on the File menu (see Print Preview Options image below). Selecting either of
these options takes the user to the Print Preview window where the PacePlus data product is displayed and may be
printed.

Print Preview Options
Click on the Print Preview button or the File menu, Print Preview option and a new window, the Print Preview
window, is displayed (see PacePlus Print Preview image on the next page). This window looks essentially the
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same as what will be sent to the printer except that the print preview window is adjusted to display an optimum size
window depending on the display settings of the user’s system.
This window displays a screen in the same format as the printed data product. The image below is shortened to two
races for space considerations. In most cases, 3 or more races will be displayed on the user’s monitor and this varies
by the display resolution setting.
For a race that has been given a name, e.g., the True North Handicap in this example, the name of the race is shown
above the race data displayed or printed. A number of named races has been collected and are included with the
program but not all by any means. An update to the file containing the information for these races will be posted as a
download on the web site as additional races are added.

PacePlus Print Preview

Program Modes
In Print Preview, PacePlus has two modes of operation, PacePlus (the default) and Pace Evaluator.
When the Print Preview window opens, it defaults to the PacePlus mode. This displays or prints all horses in all
races. Various options allow the user to narrow the display and printing of horses to be handicapped for a race.
These controls are implemented through the menu system.
The following discussion addresses the menu system and the user options available via the menu system.
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PacePlus Menu

PacePlus Mode
PacePlus Menu System. The window has ten menu options: Program Mode, Print Data, Next, Reset, Show Detail,
Hide horses, Scratch, APV, Results and Race Cond. Each menu option provides the user choices of program behavior.

Program Mode Menu
Program Mode. The Program Mode Menu provides 4 options as shown in the Program Mode Options image
below.

Display/Print Menu Options
The Program Mode menu options are Contenders and All horses. The menu option presented is the mode to which
the program will change when that menu option is clicked, e.g., clicking on Contenders in the Program Mode menu
will switch the display and print mode into the Contenders mode, i.e., only horses which are selected by the
PacePlus contender algorithm are displayed or printed.
Since the program default mode is to display all horses, the menu option initially available is Contenders.
All Horses. PacePlus defaults to the mode in which all horses are displayed. Selecting this menu option causes the
menu option to change to Contenders.
Contenders. This option turns on the selective display mode (see Contenders Mode image on the next page) and
allows the user to view the data for horses determined potential contenders by PacePlus. The contender selection of
PacePlus is a proprietary process which presents four horses as an estimate of the most likely potential winners.
2-33

Contenders Mode
When this option is selected, the menu option changes to All horses and the display is redrawn to display only
projected contenders in each race (see All Horses Mode image below).

All Horses Mode
Pace Evaluator. This menu option causes the program to switch to Pace Evaluator display and print mode.
Display/Print. This menu option reveals two additional options via a submenu, Normal and User customized.
Normal. This submenu option selects the normal mode for display and printing. This is the default mode for
PacePlus.
User customized. This submenu option the user customized mode for display and printing. This mode is described
later when the means of implementing the selection is explained.
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Another criterion may cause other than the Contenders or All Horses display. If the
button was clicked on
the FPS/Time window, the horses selected by the user at that time are the only ones displayed. To return to a normal
display, the user may open the Hide horses menu option for the affected race and click the
button.
Close. This menu option directs the program to close the print/preview window.
Print Data. The Print Data menu has four menu selections, one applies to the PacePlus mode, two apply to the Pace
Evaluator program mode and one applies to both program modes. The PacePlus option is enabled in PacePlus mode.
The Print Plus submenu has options to print the race program data for All races and for Selected races if the user
does not desire all races printed. The Select Printer option allows the user to select the desired printer when multiple
printers are available.

Print Data Menu
When the All races option is selected, the program prints all races either printing data for all horses or contenders
depending on the current program mode selection.
When the Selected races option is selected, a display appears which allows the user to select as many of the day’s
races as desired to be printed. The control is illustrated in the Race Selection image below.

Race Selection
When a race is selected for printing, the corresponding check box is checked.
button allows the user to remove all selections and begin the selection process again. A single race
The
may be deselected by clicking so the box is not checked. In the example above, the user has chosen to print races 3,
6, 7 and 12.
button closes the race selection display and retains the race selections the user has made. The
button closes the race selector, executes the Selective races print option and prints the races chosen by the
user. The program clears the selections once the selective print operation is complete.
The
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Next. This menu option causes the program to display the next group of races on the display beginning with the race
after the last race currently displayed. If the last race on today’s program is displayed on the current screen, the Next
option is disabled.
Reset. This menu option allows the user display the first group of races again beginning with Race #1 on today’s
program.
Show Detail. This option provides a list of the races on this card and provides the means for the user to select the
race for which to display detailed information. The information provided in the Detail display is essentially the same
info displayed on the print preview screen page. The advantage of Detail display is that the data can be sorted on any
of ten fields.
In addition, the program will accumulate three sets of data in the rightmost columns labeled 1, 2 & 3 (see Print
Preview with Show Detail image below).

Print Preview with Show Detail
Selecting Race #1 from the Show Detail menu produces the display shown above with the Show Detail display
positioned below the race of the same number. If the Show Detail is for other than the first race on the page, it is
displayed above that race.
On the next page the Show Detail box is shown full size for clarity. It contains the same information as the print
preview screen with minor exceptions. The S and R columns are displayed singularly on the preview while both are
included in the detail display.
Placing the mouse cursor over the colored border of the Show Detail display provides this displayed assistance
message:
. To reposition the Show Detail display to a user preferred position, press and hold the
left mouse button while dragging the top edge of the control to the desired position.
The Show Detail box has two buttons showing, the
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button and the

button.

The

button allows the user to clear (reset) the counts accumulated in the 1, 2 and 3 columns.

button provides the means to capture the information displayed in the Show Detail box for the User
The
customized print mode.
To close the Show Detail box, click the

button.

Show Detail
The image below shows the results of clicking the AR column header. The program accumulates counts based on the
horse’s position in the sorted order for each of the columns.

Show Detail with Data
Once the data are accumulated in the 1, 2 and 3 columns, the user may have this data saved so it also appears in the
print preview screen and the PacePlus print product. To collect this data so it is stored for display and printing, click
the
button.
Note: The %E and Mu columns do not contribute to the data accumulated in columns 1, 2 and 3.
Column 1 is incremented each time a horse sorts to the top of the column for all columns from S to E (excluding %E
& Mu as noted above). If there are multiple horses with the same value in the sorted column, all are incremented.
When column 1 is sorted, the higher number sorts at the top indicating at the top of the list the horse having the
highest number of upper sort results.
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Column 2 accumulates a value based on the position in which the horse sorts for columns Spd through E. The higher
in the list the horse sorts, the smaller the number accumulated.
A column 3 accumulates a value based on the position in which the horse sorts for columns S through E. The higher
in the list the horse sorts, the smaller the number accumulated.
When columns 2 and 3 are sorted, the lower number sorts at the top indicating at the top of the list the horse having
the highest number of upper end sort results.
Hide horses. This option provides a list of the races in this card and provides the means for the user to select the
race for which to hide horses. The user can use this tool to remove horses temporarily from those displayed or
printed for the user’s handicapping analysis.
Clicking on a race number displays the hide horse tool (see Hide Horse Control Display image below).

Hide Horse Control Display
The Hide Horse tool is displayed below the Show Detail box. In other cases, the two tools are displayed in a manner
so they do not cover the race with which they are associated. The full size view of the hide horse tool is shown in the
Hide Horse Tool image on the next page.

2-38

Hide Horse Tool
To hide a horse, click on the checkbox so it is checked. Clicking Refresh causes the display and the Show Detail
boxes to be updated to reflect the list of horses desired. Click the Clear control to have all the checkboxes
unchecked, i.e., for all horses to be displayed.
Like the Show Detail display, the Hide Horse control may be repositioned by the user to a desired position on the
screen. Moving the mouse cursor over the colored border yields the assistance message
.
Press and hold the left mouse button on the colored border and the control upper left corner snaps to the cursor
position. As the user moves the mouse cursor, the Hide Horse control follows. When the user releases the mouse
button, the Hide Horse control stays in the position at which it was released.
To alert the user that the Show Detail box and hide horse tool are for different races, the border color of the hide
horse tool changes to an orange color.

Hide Horse to Detail Mismatch
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This is illustrated in the Hide Horse to Detail Mismatch image above. When the mismatch is corrected, the Hide
horse control background matches the Show Detail box background color.
In Pace Evaluator mode, the mismatch alert is based on the race displayed on the print preview screen. The Show
Detail and Hide Horse tools will have a blue background if they are for the same race as specified on the underlying
page. If either or both are for different races, the orange background to alerts the user to the race to tool mismatch.
Scratch. This option provides a list of the races on this card and provides the means for the user to select the race
for which to scratch horses. This tool is provided to give the user an option to remove horses from the handicapping
process by a separate means than the hide horse feature. A horse scratched from the race will not be available in the
hide horse tool thus using the hide horse tool cannot inadvertently reinsert the scratched horse into the handicapping
process.

Scratch a Horse
To scratch a horse, click the checkbox so it is checked. When the scratch control is closed by clicking the
control, the print preview and detail displays are updated to reflect the horse(s) removed or restored.
Like the Hide Horse control, the Scratch control may be repositioned by the user to a desired position on the
screen. Moving the mouse cursor over the colored border yields the
assistance message.
Press and hold the left mouse button on the colored border and the control upper left corner snaps to the cursor
position. As the user moves the mouse cursor, the Scratch control follows. When the user releases the mouse
button, the Scratch control stays in the position at which it was released.
Scratch and Hide Horse Effect. Both of these controls cause a horse to be removed from the display or printout in
both the PacePlus and Pace Evaluator windows.
Scratching a horse in one mode means it is scratched in both modes for both display and print.
Hiding a horse in one mode means it is hidden in both modes for both display and print.
APV. This menu allows the user to select between the Average Purse Value for the horse or a series of values
indicating a recent (within the two most recent PPs) claiming or trainer change, the owner or breeder is the trainer
and based on distance information from the PP record if the horse has moved from sprint to route or from route to
sprint.
The APV menu option brings down a Show APV option (see APV Menu image on the next page). The
option checked as at the left shows that the program will display the Average Purse Value for this horse. The APV is
displayed and printed in red and is rounded to $100.
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APV Menu
When the
is not checked as at left, the APV is not presented. Instead the three alternate information
items described below are presented.
Claimed or Trainer Change. The first of 3 columns indicates the horse was recently claimed or the trainer has
changed. If the horse was claimed, a trainer change is implicit so the claimed (C or C1) information is presented. If
the horse was not recently claimed but the trainer has changed, the T or T1 indicator is presented. T1 (C1) signifies
the Trainer change (Claiming) was before the most recent PP and a T(C) indicates the change (claiming) occurred
since the most recent PP.
Owner/Breeder is Trainer. The second column indicates the trainer relationship to the horse if any. An ‘O’ in the
second column indicates the owner is the trainer. A ‘B’ in this column indicates the breeder is the trainer. The
Owner-Trainer ‘O’ is presented if both are true.
Sprint to Route/Route to Sprint. The third column shows the sprint to route [sR]/route to sprint [Rs] indicator. The
sprint to route indicator is based on 40% or less of the horse’s PPs being from sprint races and today’s race is a route
race. The route to sprint indicator is based on 60% or more of the horse’s PPs being from route races and today’s
race is a sprint. If neither condition is met, this field is blank. [Return to handicapping reference]

Customized Printing
PacePlus provides the ability for the user to define a personalized printout which best serves his needs. The
following illustrates the process to define and implement the custom display and printout. A customized display or
printout is built by the user through the Show Detail and Hide horse tools.
A feature of the customized display/print ability is the user may perform this for only the races desired, as few as
one if so desired. The program captures the race information and presents it in the order it was displayed at the time
of the capture. By sorting the race in the order desired and then executing the capture, any further display or printing
of the race is in the order it was presented at the time it was captured.
If the user wishes to alter the order or the number of horses in the customized race, he need only return to the Show
Detail box, establish the desired sample and sort order and capture again. The second capture replaces the data from
the original capture.
In the example on the next page, the user has accumulated the count totals by clicking on all column headers. These
count totals are show in columns headed 1, 2 and 3. With the counts accumulated, the user has chosen to sort a
custom selection on Column 1 (see Custom Selection image on the next page).
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Custom Selection
This provides 5 horses in the top group. The user now wants to keep only these 5 horses and remove the others.
Using the Hide horse tool, the user removes horses 1A, 2, 6, 7, 8, 9 and 10. Clicking on the Refresh control in the
Hide horse tool after these horses are hidden results in the Show Detail display shown in the Customized Race
image below.

Customized Race
button to have PacePlus save the information for this selection. The dialog shown in the Confirm
Click the
Custom Selection image below informs the user of the action invoked and asks him to confirm. Clicking the
button directs the program to save the information as specified by the user for the Customized presentation. Once
the user has captured at least one race, the User customized print option is enabled on the submenu of the Program
button rejects the customized selection.
Mode menu, Display/Print option. Clicking the

Confirm Custom Selection
In the example shown in the Custom Print image on the next page, the user has selected a customized presentation
for races 1, 2 and 3. By selecting the Program Mode menu, Display/Print option and then the User customized
submenu option, the user gets the display shown which includes only the user specified races.
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Custom Print
The selection of races 1, 2 and 3 is arbitrary. It could as well be races 2, 4, 5 and 8. The resulting display and print
products in the User customized mode will display or print only the races selected by the user.
Results. This menu opens a new window in which the user can display race results. The Results window is also
displayed from the History window when the user needs race results to add data to the history data file.
The Results window is useful only if the user downloads the results files from a site like Brisnet or Daily Racing
Form and saves them on his computer. This option is provided for users who wish to recap a race to look for
information to integrate into their handicapping tool repertoire. The Results window shows the track code or name,
the race date and a listing of race number, the winning horse and what the horse paid.
The Results window remains open until closed by the user or until the user closes the Print Preview window which
action also closes the Results window. The Results Window image on the next page shows the appearance of the
results window.
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Results Window
The results window recognizes 3 types of files all of which are web type files, i.e., Hyper Text Markup Language
(HTML), the most basic language used to create web pages. The DRF web site provides the free results in two
different formats. PacePlus results reads both file types. Brisnet provides a single type which is common enough in
format to the TSN web site that the program also reads the results file from either web site. PacePlus will identify
the file source or if it does not recognize the results file, it will indicate “Unknown file type.” and provide no results
info.
The program does not read Adobe© PDF files or other formats in which results are provided. In order to use the
results feature, the user must access the results on the TSN, Brisnet or DRF web site and save the file on his local
computer. The PacePlus program reads files created by both Microsoft Internet Explorer version 6 (IE6) and version
7 (IE7).
Results Disclaimer: Since the format in which these pages are created is at the discretion of the various web hosts
and is subject to change at any time, this feature may not correctly read future changes to these files. If such a
circumstance occurs, we will try to keep the program updated to support the new format(s) but support for this
feature is not as strong as the parts of the program designed to assist the user’s handicapping efforts.
During the installation process, the PacePlus installer creates a directory for race results files. The suggested process
for the user is to create a subfolder for each track handicapped. When files are stored, using a naming scheme of
track name, year, month, day will create a set of files automatically sorted in date order. For example, for the race
results shown above, the suggested name is Belmont 2008-06-07.mht. The file extension is mht, a type of web file.
Saving Results. The Save Results File image on the next page shows the Microsoft browser, Internet Explorer or
IE, save file dialog box with the suggested file name protocol example.
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Save Results File
If the Save as type selection is not as shown above, set it to this selection. IE should remember this selection once
the user has chosen it once but it is always good the check the setting before saving the results file.
The Save Results Options image below shows the options available for saving results files. The available options
include 4 types. Two types described below are recommended for PacePlus users.

Save Results Options
Webpage, Complete [*.htm,*.html]. This option is not recommended because it creates new folders and saves image
files from the host web site creating considerable clutter on the user’s system.
Text File [*.txt]. This option is not supported by PacePlus results processing. The format of the file makes extraction
of the information very difficult from a programming perspective.

2-45

Web Archive, single file [*.mht] or Webpage, HTML only [*.htm,*.html]. Each saves a single file on the user’s
system and PacePlus can extract the winner info from either file type. Either format is recommended with the .htm
or .html file type using less space on the user’s system. Typically, the html file uses about 10% to 20% the space of
the mht file type, a distinct advantage if space is a consideration.
Race Cond. This menu provides a list of the races on this card and provides the means for the user to select the race
for which to display the race conditions field from the data file. This is the information shown at the top of the
racing form. The information is displayed in a separate window and is updated when the user selects a different race
from the Race Cond menu (see Race Cond Menu image below).

Race Cond Menu
When the race condition race selection is made, the program opens a new window and displays the race condition
info.

Race Condition Window
The Condition line window remains open until closed by the user or until the user closes the Print Preview window
which action also closes the race condition window.

Pace Evaluator Mode
Selecting the File menu Pace Evaluator option switches the program to the Pace Evaluator mode. This mode is very
similar to the Pace Evaluator program and will be familiar to those users familiar with the earlier program. In
PacePlus, the Pace Evaluator mode allows the user to employ some of the PacePlus enhancements, specifically, the
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Show Detail, Hide horses and Scratch tools. The Results and Race Cond menu options are also available in this
mode.

Program Modes
Pace Evaluator Menu System. The window has eight menu options: Program Mode, Print Data, Display Race, Show
Detail, Hide horses, Scratch, Results and Race Cond. Each menu option provides the user choices of program
behavior. All these menu options are as described for PacePlus except the Display Race option and the Print Data
menu selections described below.

Pace Evaluator Menu
Below the menu items is a navigation bar. In it, the present race number and the number of races are displayed at the
left end. To the right are controls to move sequentially from race to race. The Next Race option moves to the next
higher race number and is disabled when the last race is displayed. The Prev Race option moves to the next lower
race number and is disabled when the first race is displayed.
There is a More control which is enabled when the race data display requires more than one window (see Pace Print
Preview - More image on page 2-49). When a race has more data than can be displayed in one window, the data
that can be displayed is presented in a single window, the More control is enabled and the Prev Race and Next Race
controls are disabled.

Pace Evaluator Print Preview Display
For users familiar with Pace Evaluator, there are some new options on the Pace Evaluator menu system. The Next
and Reset menu options disappear and are replaced with the Display Race menu option.
The Print Data menu now has the Pace Evaluator options enabled and the PacePlus option disabled (see PE Print
Menu image on the next page).
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PE Print Menu
Like PacePlus, this menu provides an option to print all races or via the Selected race submenu, any user specified
race. The submenu allows the user to specify the race to be printed (see PE Display Race Menu image below).

PE Display Race Menu
The presentation provides today’s race information across the top of the display. The track name, race date, race
number, race class and distance are shown. For race distances of 8 or more furlongs, the distance is shown in
furlongs and in miles followed by the turf indicator. Finally, the page number is displayed. The page number is the
same as the race number.
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Pace Print Preview-More
One program calculated value is shown on the print preview and printout that is not displayed on the previously
described display. This value is an average for each horse for previous races at today’s race distance. The number
following the average separated by the slash is the number of races used to calculate the average, e.g., Tizbig had 2
races in past performances that contributed to the Avg TPR at today’s dist figure (162/2).
Today's Avg TPR. This figure is calculated slightly differently depending on today’s race distance. No average is
provided for 5.5f or shorter races. The following table shows the distances used to produce this average value. For
distances greater than 9f, the program computes the average based on races of the same distance as today’s race.
Today’s race distance
6f, 6.5f
7f, 7.5f
8f
8.2f, 8.3f, 8.5f
9f and more

Average race distances
6f and 6.5f
7f and 7.5f
8f
8.2f, 8.3f and 8.5f
distance match only2

When the last data for the multi window display is presented, the More control is again disabled and the Prev Race
and Next Race controls are enabled as appropriate (see Print Preview – More Done image on the next page).

2

9f PPs ONLY used for 9f race, 10f PPs for 10f race, etc.
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Print Preview – More Done
Also note that the second page number has a suffix of a. This indicates the second group of data displayed for this
race. If there are more then two segments to be displayed, each will have a suffix of b (3rd segment), c (4th segment),
etc., each indicating a sequential page.
The Display Race menu provides as many choices as there are races and permits the user to go directly to a specified
race for display without the need to step sequentially through each race to have certain race data displayed.
The Print Data menu has two printing options. The first is to print All races. When this option is chosen, all races are
printed for the current data file. Races are printed sequentially beginning with race 1 and the pages numbered with
the race number. As with the display, if subsequent pages are required for the printout, each subsequent page has a
page number suffix of a, b, c, etc.
Unlike the screen display, the program will not split the data for a horse across a column boundary on the printed
page. If the data cannot be printed completely in the left column, it is printed at the top of the right column.
The print option is designed for the standard 8-1/2” x 11” page, portrait orientation and uses the system default
printer. The program prints in color. If the user’s printer is a monochrome printer, some items will probably show as
grays of varying darkness.
The Print Data menu option Selected race also gives as many options as there are races via a pullout menu. Selecting
a specific race from the pullout causes only that race data to be printed.

Automatic Unzip
When the PacePlus program starts, it checks the default directory, C:\PacePlus\BrisDownLoad\, for new files the
user has downloaded. If there are new zip files (not the sample files provided with the program), the program unzips
the new files and stores the DRF, MCP, EG or PCS files in the default directory, C:\PacePlus\DRFdata\.
In PacePlus, the extracted file is renamed so the file name contains the year giving a complete identity to the race
file. This enables the user to retain a historical set of data files.
If the file is not renamed, a file from a previous year for that track run on the same month and day will be
overwritten and lost.
Once the zip file contents are extracted, the zip files are moved to an archive directory so they will not be processed
again. The default archive directory is C:\PacePlus\BrisDownLoad\Archive\. As with the extracted data files, the
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zip files are renamed when moved into the Archive directory thereby allowing the user to accumulate a multi year
history of download zip files if desired.
The program also periodically checks for new downloads while it is running and if it finds a new download,
automatically extracts the contents and moves it to the archive directory. The capability to manually select and unzip
a file is still available in the menu system. This permits a new user to access the sample files as desired to become
familiar with the program. The sample zip files are NOT archived nor are they renamed.

Bad Zip File
Occasionally, a download process will result in an incomplete file transfer or a corrupted file downloaded.
When this happens, the Unzip function called by the program will detect an unrecoverable error in the download file
and will not be able to extract the data file contained in the zip file.
In this situation, the only solution is to delete the current download and download the zip file from Brisnet again.
If this situation is detected by the program, it displays a message box like the one below (see Bad Zip File Alert
image).

Bad Zip File Alert
Note the bad file is identified in the second line of the message box. Remember this file name so it can be
downloaded again to get a valid file.
Once the user clicks the OK button, the program deletes the bad file so the same error does not recur.

Unzip from PacePlus
The user may initiate the uncompress function from within the PacePlus program. To initiate the unzip process,
select Uncompress [unzip] file from the File menu. The Open Download file dialog box is shown for the user to select
the zip file to be opened (see Select zip file image on the next page).
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Select zip file
Once the user selects the desired file and clicks the Open button, the program displays the Extract DRF file to dialog
box (see Extract File to image on the next page) asking the user to select the directory in which the extracted data
file will be saved. This directory initially defaults to the C:\PacePlus\DRFData directory and a file name the same as
the ZIP file with the DRF extension.
The default directory is C:\PacePlus\DRFData, the user defined directory selected at installation (refer to PacePlus
Directories images on page 2-2 through 2-4) or the most recent directory in which the user chose to save an
extracted data file.
The PacePlus program remembers the most recent directory from which a zip file was retrieved and defaults to that
directory on subsequent unzip actions.
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Extract File to
Clicking the Save button causes the PacePlus program to extract the data file to the user selected directory.
The default folder is C:\PacePlus\DRFData if the user selected the default install option. Otherwise, the default
directory is the user defined directory selected at installation (refer to PacePlus Directories images on pages 2-2
through 2-4) or the most recent directory from which the user selected a data file.
The PacePlus program remembers the most recent directory in which a data file was referenced and defaults to that
directory on subsequent unzip actions.

Download Custom PP Generator Free Software (return to referring link on page 1-13)
Brisnet also has a free program which allows the user to make the past performances from the downloaded Brisnet
data files. This program permits you go create your own customized Past Performance format.
To download this software, follow the instructions starting on the next page.
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Make a new folder called Custom PP on your system. Download the free Custom PP Generator program to the
Custom PP folder.
To download this program, go to the www.Brisnet.com and click on

image (see below).

Click here
Then you will get this page.

Click here,

When you click on the Custom PP Generator image, you are taken to a page that displays the information shown
on the following page.
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At this page, begin the software download by clicking on the full install version link (see image below).

Click on this link to
download the program.

A File Download dialog box is displayed by Internet Explorer as shown in the IE File Download image below. For
those using a different browser, the download dialog will appear somewhat different but will have the equivalent
controls to accommodate the file download.

IE File Download
Click Save and IE displays a Save as dialog box (see IE Save as Dialog image on the next page). Select the Custom
PP directory using the Save as dialog box.
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IE Save as Dialog
For users with the Netscape browser, clicking on the Brisnet web site link displays a dialog box like the one shown
in the Netscape File Download image below. Select the desired directory and click Save.

Netscape File Download
For users with the Netscape browser, clicking on the Brisnet web site link displays a dialog box like the one shown
in the Netscape Save as Dialog image on the next page. Select the desired directory and click Save.
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Netscape Save as Dialog
When the download is complete, select the Custom PP folder and you will find a file named briscustppfull2279.exe3.
Double click on this file and follow installation instructions (see Custom PP Directory image below).

Custom PP Directory
When installed, the Custom PP Generator puts an icon on your desktop and on the Program menu accessed from the
button on the Windows Task Bar.
Installing the Custom PP software creates a directory structure as illustrated in the Custom PP Installed image on
the next page. The Custom P Generator program by default looks for the files downloaded from Brisnet in the
C:\BRISCust\Data directory. The user may change the setting to make the program look in any desired location.

3

This is the file name as of the date of this manual. Future development of this software may produce a different file name.
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Custom PP Installed

Custom PP Data Files
PacePlus users who already use the Custom PP software store their download files in the C:\BRIScust\Data directory.
For PacePlus users who have not used Custom PP, our recommended download directory is the
C:\PaceEval\BrisDownLoad directory.
File Location. The download files may be stored in the location most convenient for the user. Custom PP will unzip
a download file and places the extracted DRF file into the same directory in which it found the ZIP file. PacePlus
will also unzip a download file but permits the user to specify the directory in which to save the extracted file.
PacePlus stores the extracted files in the C:\PaceEval\DRFData directory by default. The user may specify any
convenient directory and PacePlus remembers the specified directory until the user changes it.
Custom PP File Default. If the user wants his download files saved in a different location than the Custom PP
Generator’s default location, he can direct Custom PP Generator to assign a user defined default location for file
access.
To change the location in which Custom PP Generator looks for its data files, Click on the System menu and select
the Default File Directory option (see Set Default Path image below).

Set Default Path
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Selecting this option presents the Change Data Path window of Custom PP Generator as shown below. When the
window opens, it displays the current setting for the default file location, in this case, the default installation setting,
C:\BRISCust\Data.

Change Data Path
Using the drive and directory selector controls, navigate to the directory desired as the new default location. In the
Change Data Path Updated image below, the user has navigated to the C:\PacePlus\DRFData folder [directory]
where the PacePlus program looks for its source data files by default.

Change Data Path Updated
button to make the change effective.
When the user has navigated to the desired location, click the
Once the change is effective, Custom PP Generator looks in the newly defined location for data files until the user
selects a new location.
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Running Custom PP
When the user initially starts the Custom PP Generator, the displayed window looks like the Custom PP Generator
image below. Note the image below has been cropped to fit the page and is intended to show the user what to expect
from Custom PP if the user is not familiar with this software.
On subsequent starts, the Custom PP program displays the most recently selected race.

Custom PP Generator
When the File menu is clicked, the selections available are like that shown in the Custom PP File Menu image
below.

Custom PP File Menu
Clicking on the Load File menu option displays a file select dialog box like the Select Data File image on the next
page. In this example, the Custom PP Generator has been set to default to the C:\PacePlus\DRFData folder.
In the example, the user has selected the data file for Saratoga for August 18, 2005.
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Select Data File
Click the
button to open the file in Custom PP Generator. You now have free Past Performances
displayed in a format very similar shows the display for a Past Performance derived from the data file extracted from
the downloaded ZIP file to the Premium Plus PPs downloaded from Brisnet in the comma delimited format. The
Custom PP generator allows the user to customize the presentation with numerous options.
This program permits the user to print the Past Performance information as well.
The Custom PP Display image, on the next page, shows a partial example of the information displayed by the
Custom PP generator. The Custom PP generator has numerous options permitting the user to tailor the information
presented to his particular desires.
Note: The Custom PP Generator from Brisnet will only read files downloaded from the Brisnet web site. If the user
attempts to load a file downloaded from TSH Horse, the Custom PP Generator will report it as corrupted and will
not display the data. On the other hand, the TSN Custom PP Software program will read Brisnet download files as
well as TSN Horse downloads.
Return to referring link on page 1-13.
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Custom PP Display

View Racing Form from PacePlus
This section is for users who download the Brisnet Premium Plus PPs in the Adobe Portable Document Format (pdf file).
This is Brisnet’s equivalent for the Daily Racing Form. For users who view the Past Performances using the Brisnet Custom
PP Generator, this section of the manual is not needed.
The user may initiate the display of the Racing Form (the Premium PPs) downloaded from the Brisnet web site from within
the PacePlus program. To initiate the Racing Form display process, select Show Racing Form from the File menu. The Display
Racing Form file dialog box is shown for the user to select the .pdf file to be opened (see Show Racing Form image below).
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Show Racing Form
If the Acrobat Reader program has not been installed, the operating system will not be able to find the program to
display the .pdf Racing Form file and the user will see an Open With… dialog similar to the one shown below (see
Open with... Dialog image). If this dialog is displayed, close it and install Acrobat Reader program from the
distribution CD-ROM or download it from the Brisnet [www.brisnet.com] or Adobe [www.adobe.com] web sites.

Open with... Dialog
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Switching Documents in Acrobat
Once the user selects the desired file and clicks the
button, the PacePlus program passes the file to the
system requesting the Acrobat Reader be opened to display the Racing Form file. The user then may then view and
print the racing form from Acrobat as desired.
If you open both the PacePlus document and the Racing Form, Acrobat Reader may not open a second time. Instead,
the second document will be opened in the same instance of Acrobat. To switch from one document to the other, go
to the Window menu of Acrobat and select the desired document (see Switch Documents in Acrobat image
below).

Switch Documents in Acrobat
Looking at the Window menu, the last two menu entries are the two open documents. In this case, document 1 is the
PacePlus user guide and document 2 is the racing form file downloaded from Brisnet.
The check mark adjacent to the bel0605p.pdf denotes that the document currently displayed is the racing for file.
Click on the other document to display that document in the Acrobat Reader. The menu will disappear and the
selected document is displayed. Looking at the menu again shows the user guide document as the currently
displayed document (see image below).

Switch Documents to User Guide
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Switching Applications
To return to the PacePlus program, the user may close the Acrobat Reader but this may not be desirable in many
cases. Perhaps the user needs to refer to the user guide while operating the program. In such a case, it is not practical
or reasonable to close and reopen the user guide window each time the user wishes to reference it.
To switch between applications, the user may do so by going to the Windows Task Bar (usually at the bottom of the
display). Each running program appears as a block or tile on the Task Bar (see Windows Task Bar image below).
At the left is the start button and to the right are the tiles indicating the running applications [programs]. To bring a
desired running application to the top (make it the current active program), click on its tile on the task bar.

Windows Task Bar
In the above example, Acrobat is the active application (its tile appears depressed) displaying the racing form file.
The tile to its left is the PacePlus program. Clicking on its tile will bring the PacePlus to the foreground (see
Changed Application image below).

Changed Application
Note in the above image that the lower portion of the PacePlus screen is visible atop the Adobe document display
and that the PacePlus tile on the Task Bar appears depressed (signifying it is the application which currently has the
attention of Windows).

File Cleanup
Using the PacePlus program for a period of time means the accumulation of data files. For each race processed, the
user may accumulate up to five files. At some point, this accumulation of files becomes clutter in the user’s folders
and may interfere with finding the desired files for current races.
In order to permit easy management of this potential problem, the PacePlus includes a function to remove old files.
This function erases ONLY files associated with the PacePlus program and cannot be used to erase other files on the
users system. This function is selected by choosing the File cleanup option of the File menu.
When the File cleanup option is selected, a window is displayed containing the controls for the file clean up process.
The window contains a box with a default date specifying the dates of files to be erased. The program will erase files
with dates on or before the specified date.
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The window also has a check box to retain sample files provided with the PacePlus program. This option allows the
user to keep these samples if desired. If they are erased and are later desired, they may be copied from the
distribution CD-ROM to the user’s system. The only sample files that are retained are the Brisnet download files
[.zip files] and the racing form downloads [.pdf files]. There are four files of each type in each of two directories.
There are two command buttons on the form also. One is the command to remove files and the other is to close the
form and return to the PacePlus program.
When the File Cleanup window is initially displayed, it selects a default date for file removal of one week prior to the
current system date (see File Cleanup - Default Date image below).

File Cleanup - Default Date
In the image above, the default date is displayed as 11/23/2008. The Keep files check boxes are checked for Sample
files, Zip files and DRF files which tells the program to erase only the PacePlus generated files created on or before
the specified date. If the user desires, a different date may be specified by typing it in the text box and replacing the
default date.
If the user enters a date, the program checks that the date entered is valid. There are two possible error conditions.
One error is the user types an entry that is not a valid date. An example of an invalid date entry and the program’s
response is illustrated in the File Cleanup - Invalid Date image on the next page.
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File Cleanup - Invalid Date
The other possible error condition as far as the program is concerned is that the user specified a date that is valid but
is in the future (see File Cleanup - Future Date image below). Such an entry would result in the deletion of all
PacePlus files on the user’s system. If the user desires to remove all files, specifying the current date will accomplish
that. The rejection of a date in the future is an effort to prevent accidental erasure of files the user may wish to retain.
If the user wishes to keep files for future reference but does not want them in the PacePlus folders, the desired files
may be copied or moved to a desired destination at the user’s discretion.
Once the user responds to the Invalid date message box, the program restores the originally suggested date.

File Cleanup - Future Date
Keep Files Options. This option allows the user to retain for historical purposes files downloaded from his chosen
source web site in addition to the Sample files provided with PacePlus. The user may opt to retain the zip files
downloaded. In addition he may opt to keep the files extracted from the zip file downloads. This includes the .MCP,
.PCS and .EG files as well as the .DRF files.
By default, the user’s source and sample files will be retained. If the user wishes to have them removed, he must
uncheck the desired selections to have old files removed.
To retain the sample files, click the checkbox as indicated in the File Cleanup – Keep Files image below.

File Cleanup – Keep Files
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Once the user is satisfied with the specified date and wishes to proceed to remove the applicable files, clicking the
Remove files command button initiates the actual file erasing process.
The program then proceeds to erase all PacePlus data files for the date range specified. As the files are deleted, they
are listed in a Deleted files text box that is displayed once the Remove files button is clicked.
The list of deleted files remains displayed until the user clicks the Close window button to return to the PacePlus
program (see File Cleanup – Deleted File List image below).

File Cleanup – Deleted File List
On the next page is another example in which the user selected to remove all files except the Sample files provided
with the program and there were a large number of files to be removed. The process takes a significant period of
button is disabled preventing the user from
time. To permit the process to continue to completion, the
terminating the process prematurely (see Cleanup Working image on the next page).
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Cleanup Working
When the file removal is finished, the user may scroll down the window to review the list of files as desired. The
process completion is indicated by the display of the File removal done message at the lower right of the window
(see Cleanup Complete image on the next page).
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Cleanup Complete
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Section 3
Adobe® Acrobat Reader
To view the racing forms [Premium Plus PPs] downloaded from Brisnet, the user needs the Adobe® Acrobat
Reader program, a public domain program which will open, display and print the racing forms which come in .pdf
files [Adobe’s® Portable Document Format]. This program may be downloaded at a number of web locations and
Brisnet is one of them (see Brisnet Home Page image below). It is also available from http://www.Adobe.com. A
copy is also provided on your distribution CD-ROM and is installed when you install the PacePlus program.

Brisnet Home Page
Click on the

link on this page and the following page is displayed.

Look down the list of selections and find the Scratch Sheets entry. In the right hand column of this entry is the first
of several links to download the Acrobat Reader. Follow one of these links to download and install the acrobat
reader to be able to read and print the racing form files downloaded from Brisnet.

Brisnet Acrobat Reader Download Links
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